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Apresentação

Pretende-se, neste módulo, abordar os conteúdos essenciais para a realização das 

operações básicas de planeamento de trabalho. O aluno deverá entender que, na 

realização de um projeto gráfico, a seleção da(s) aplicação(ões) a utilizar, bem como 

a transferência de ficheiros em específicos tipos de formato digital, fazem parte do 

processo de edição transversal, tal como, a preparação de todo o trabalho para ser 

executado em gráfica.

Objetivos da aprendizagem

Identificar as fases estruturantes de um projeto gráfico;

Utilizar, em conjugação de tarefas, os diversos aplicativos de edição e paginação;

Identificar as fases fundamentais da edição: introdução, tratamento e saída;

Caracterizar os diferentes formatos dos conteúdos digitais;

Selecionar os processos e aplicativos apropriados aos conteúdos a manipular, tendo em 

vista os objetivos de edição;

Identificar os métodos e estilos de trabalho otimizadores do fluxo de produção, à 

semelhança dos utilizados em meios profissionais.

Âmbito dos conteúdos

Estruturação de um projeto gráfico;

Deteção do problema;

Definição dos objetivos;

Faseamento e calendarização;

A sequência formal da edição;

Organização dos diferentes conteúdos;

Tratamento da informação: Textos, gráficos, fotografias, diagramas, entre outros;

Tipos de formatos digitais: Eps, jpeg, tiff, e outros;

Digitalização de opacos e transparências;

Importação e exportação dos conteúdos;
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Maquetização;

Montagem dos conteúdos;

Provas e revisão gráfica;

Preparação para impressão.
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Projeto gráfico

É o plano inicial que definirá as características visuais de um peça de design gráfico. 

Projeto gráfico é um conjunto de elementos que formam e dão características a um meio 

de informação.

No jornal impresso, o projeto gráfico define principalmente o formato do papel, a famílias 

tipográficas usadas e a malha tipográfica (o grid).

Um bom projeto gráfico editorial é aquele que conduz os olhos dos leitores sem se 

tornar o elemento principal daquela página. Sem interferir na qualidade da leitura. As 

imagens, o tamanho das fontes tipográficas, a posição de títulos, reticulas, boxes, fios, 

enfim, todos os elementos visuais devem ser adequadamente pensados e posicionados 

com o objetivo de atender a uma necessidade editorial.

Um projeto gráfico é constituído de uma série de plataformas que formam a sua lógica 

construtiva. Estas estruturas definem o seu aspeto de visual - layout - (cores, tipografia, 

design, etc.), bem como seu aspeto editorial (textos, linguagem, conteúdo). Geralmente 

um projeto gráfico é antecedido de uma série de perguntas junto ao cliente, o que 

se denomina briefing. O objetivo do briefing é enfatizar questões que servirão de 

ferramentas relevantes na constituição do projeto. Para desenvolvimento de um projeto 

gráfico, são necessários aproximadamente de sete a dez dias antes da etapa seguinte, 

que é chamada “Reunião de pauta”, evento em que se reúnem os Designers e as equipes 

de Marketing, Publicidade e Edição.
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A finalidade é justamente determinar qual o formato que o projeto gráfico terá e de 

que forma ele será representado nos média. Leva-se em torno de dez dias de produção 

editorial antes da publicação propriamente dita do projeto gráfico. Nesta etapa são 

realizados uma série de procedimentos que revisam a própria estrutura do projeto. 

Na próxima etapa é realizada a diagramação, evento que une os aspetos visuais de um 

projeto com os aspetos gráfico editoriais. Leva-se em torno de sete dias para tal. Feito a 

diagramação é enviado ao cliente um layout para ser aprovado. Com a aprovação é feita 

a revisão ortográfica e enviada à gráfica o material, que retornará com uma prova que 

antecede a publicação. Até então leva-se aproximadamente 10 dias em média. Validadas 

as provas editoriais, dá-se início à publicação do material, evento que já antecipadamente 

é fonte de reunião entre as equipes de publicidade e propaganda.

Exercício número 1

PROPOSTA DE TRABALHO

O projeto gráfico é constituído de uma série de plataformas que formam a sua lógica 

construtiva que define o seu aspeto de visual como cores, tipografia design. Verdadeiro 

ou Falso.
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Características das extensões PDF, TIFF 
e JPEG

Para entender qual o melhor formato a ser usado para o fecho de um arquivo é necessário 

antes compreender a diferença entre imagens vetoriais e imagens de mapa de bits. 

No primeiro grupo estão gráficos de desenhos realizados a traço (chapados, sólidos, 

ilustrações, marcas, logótipos). O segundo grupo corresponde a imagens fotográficas.

Imagens vetoriais, como o próprio nome já diz, são definidas matematicamente por 

vetores — são, na verdade, gráficos com características geométricas. São consideradas 

imagens vetoriais, por exemplo, tanto um logótipo quanto um texto digitado. Imagens 

vetoriais podem ser movidas e ter o seu tamanho ou cor alterados sem nenhuma perda 

de qualidade. A definição matemática dessas imagens possibilita essas alterações sem 

nenhuma alteração da resolução final.

Programas como Illustrator, CorelDraw e InDesign permitem trabalhar com esse tipo 

de imagem e os formatos de arquivos escolhidos devem preservar essa característica 

de vetorização. Desse modo estarão garantidas linhas nítidas e sem serrilhas, 

independentemente de ampliações.

As imagens de mapa de bits, por sua vez, são constituídas por um conjunto de pequenos 

elementos, os pixels, como num mosaico. Cada pixel de uma imagem de mapa de bits 

tem uma posição determinada e um valor de cor próprio, definidos por coordenadas 

de localização e por quantificações numéricas. Se um logotipo ou texto digitado for 

descrito como mapa de bits, ao invés de vetorialmente, haverá um número definido 

de pixels que o compõe. Ao ampliarmos a imagem, esse número não será aumentado 

e a resolução poderá ser insuficiente para o novo tamanho. Como resultado, bordas 

e linhas poderão aparecer serrilhadas. Programas como o Photoshop trabalham com 

mapas de bits. Esse tipo de imagem é necessário para reproduzir gradações tonais 

subtis, como numa fotografia, mas deve ser evitado para elementos a traço, como 

textos e logótipos.
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O Adobe PDF

Criado pela Adobe Systems e aperfeiçoado durante os últimos 17 anos, o formato Portable 

Document Format (PDF) é o padrão global para a captura e a revisão de informação 

e para o compartilhamento com quase qualquer pessoa, em qualquer lugar. É um 

formato de arquivo flexível para várias plataformas e aplicativos. Com base no modelo 

de criação de imagem PostScript, os arquivos PDF exibem e preservam, com precisão, 

fontes, layouts de página e gráficos vetoriais e de bitmap. O formato PDF é o padrão 

para a distribuição e o intercâmbio seguro e confiável de documentos eletrónicos em 

todo o mundo e qualquer pessoa pode visualizá-lo e imprimi-lo com o software gratuito 

Adobe Reader. É um formato muito eficiente em processos de edição de impressão. Um 

determinado trabalho salvo em PDF transforma-se em um arquivo compacto e confiável 

que você ou seu prestador de serviços podem exibir, editar, organizar e usar para gerar 

uma prova. Em seguida, no momento certo do processo de produção, o prestador de 

serviços poderá imprimir diretamente o arquivo PDF ou processá-lo usando ferramentas 

de várias origens para tarefas de pós-​processamento, como verificações de comprovação, 

trapping, imposição e separação de cores.

Outra possibilidade é, ao salvar um arquivo no formato PDF, optar por criar um arquivo 

compatível com PDF/X (Portable Document Format Exchange), que é um subconjunto 

do Adobe PDF, com a finalidade de eliminar muitas das variáveis de cor, fonte e trapping 

que causam problemas de impressão.

O PDF/X é um padrão ISO e apresenta as seguintes opções:

PDF/X-1a:2001 e PDF/X-1a:2003 (para processos de produção CMYK).

PDF/X-3:2002 e PDF/X-3:2003 (para processos de produção com gestão de cores).

PDF/x-4:2008 (que é confiável para transparências em tempo real e gestão de cores).

O formato TIFF

O formato Tagged-​Image File Format (TIFF) é utilizado para a troca de arquivos entre 

aplicativos e plataformas de computadores. É um formato flexível de imagens bitmap 

suportado praticamente por todos os aplicativos de pintura, edição de imagens e layout 

de página. Além disso, quase todos os scanners de mesa podem produzir imagens TIFF.
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O formato TIFF suporta imagens CMYK, RGB, Lab, de cores indexadas e em tons de cinza 

com canais alfa, bem como imagens no modo bitmap sem canais alfa. O Photoshop pode 

salvar camadas em um arquivo TIFF. Entretanto, se o abrir noutro aplicativo, somente a 

imagem achatada estará visível.

O formato JPEG

O JPEG (Joint Photographic Experts Group) é usado frequentemente para exibir 

fotografias e outras imagens de tons contínuos em documentos HTML na web e noutros 

serviços online. O formato JPEG oferece suporte a modos de cores CMYK, RGB e tons de 

cinza, mas não oferece suporte à transparência. O JPEG preserva todas as informações 

de cores de uma imagem RGB, porém faz a compactação de arquivos descartando dados 

de maneira seletiva. Também é possível salvar uma imagem com um ou mais arquivos 

JPEG usando o comando “salvar” para a web e dispositivos. O JPEG oferece suporte 

somente a imagens de oito bits. Se salvar uma imagem de 16 bits nesse formato, o 

Photoshop automaticamente diminui a profundidade de bits.

Os arquivos podem ter diferentes níveis de compressão. Quanto maior a compressão, 

menor será o tamanho do arquivo, porém pior será sua qualidade. O algoritmo de 

compressão do JPEG é baseado nas limitações de visualização do olho humano. Assim, 

todas as informações que não podem ser vistas serão descartadas. No entanto, é 

necessário tomar cuidado com os diferentes níveis de compactação do arquivo. Quanto 

maior a compactação, menor será a qualidade da imagem. Uma vez compactado, as 

perdas no processo de gravação são definitivas. Da mesma forma, sucessivos comandos 

de gravação causam sucessivas perdas. Os níveis de compressão vão de 0 a 12, podendo 

ser digitados ou selecionados através da barra de rolagem constante na caixa de texto 

“qualidade do JPEG”. Assim, se for disponibilizar imagens na internet, é interessante 

mantê-las em um tamanho pequeno. No entanto, se a imagem for utilizada em um 

documento, muitas vezes é melhor mantê-la com o máximo de qualidade possível, para 

que a impressão não seja prejudicada.
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Exercício número 2

PROPOSTA DE TRABALHO

O que quer dizer as letras (TIFF)?

Exercício número 3

PROPOSTA DE TRABALHO

O formato JPEG suporta transparências?
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O briefing

A entrevista exploratória tem por objetivo esclarecer, desenvolver e modificar conceitos 

para a formulação de abordagens posteriores. É a base sobre a qual se desenvolve o 

pensamento futuro.

A palavra ‘briefing” é uma expressão da língua inglesa que significa instruções, guia; 

ação de instruir. Na publicidade, onde é aplicado usualmente, o briefing é coletado pelo 

atendimento da agência e é utilizado para orientar o desenvolvimento das estratégias de 

comunicação do cliente.

O Briefing é um documento que contém todas as informações e orientações necessárias 

para desenvolver eficazmente uma estratégia de marketing, campanha de comunicação 

ou uma simples ação de comunicação. Deverá ser fornecida à agência uma estratégia 

perfeitamente clara. O briefing vai estabelecer as orientações gerais da campanha 

que resultam da reflexão entre anunciante e agência. Devem ficar definidos os alvos, 

objetivos e possíveis limitações.

No nosso caso, será o ponto de referência para o desenvolvimento de todas as outras 

etapas do Projeto Aplicativo.

Ressalvadas as características e realidades individuais, todos os briefings devem conter  

informações sobre a empresa/cliente do projeto aplicativo em cinco dimensões:
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1. IDENTIFICAÇÃO.

2. MERCADOLÓGICA

3. ESTRATÉGICA

4. CLIENTE

5. VISÃO GERAL DO EMPRESÁRIO

Identificação

Dados básicos para conhecimento da empresa:

•	 Nome

•	 Data de Fundação

•	 Ramo de atividade 

•	 Sede - localização

•	 Composição acionaria

•	 Porte (pelo número de funcionários ou faturação)

•	 Número de lojas/filiais - localização

•	 Número de funcionários

Caso seja enfocado no projeto uma filial, fazer também a descrição específica adequada.

Mercadológica 

Descrição das características do mercado aonde atua a empresa.

•	 Descrição do segmento 

•	 Nível de concorrência

•	 Principais concorrentes

•	 Análise da situação geral do mercado (nível de demanda, influências 

económicas, sociais, políticas ou legislativas)

•	 Conceito e posicionamento no mercado

•	 Características do produto/serviço que oferece

•	 Sazonalidades do mercado
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Estratégica

Descrição dos objetivos estratégicos da empresa.

•	 Ampliação, diversificação, manutenção (Porter)

•	 Fator chave de sucesso (qualidade de atendimento, variedade de produtos, 

ponto comercial, design da loja)

•	 Política de treino e perfil da equipe de vendas (ou que se relaciona diretamente/

quotidianamente com o cliente).

Clientes

Descrever a política da empresa em relação ao cliente. Descrever o perfil do cliente. 

Levantar hipóteses sobre a satisfação do cliente.

•	 Perfil socioeconómico do cliente.

•	 Perfil comportamental do cliente (motivações para compra, razões de 

satisfação, comportamentos na hora da compra, processo de decisão, pontos 

de valorização no processo de compra).

•	 Política da empresa em relação ao atendimento ao cliente.

•	 Volume, frequência de compra – em processo de alteração ou mantido.

•	 Política e ações de comunicação com o cliente (mala direta, publicidade, 

promoção dirigida).

•	 Identificar possibilidades de insatisfação do cliente.

•	 Existência ou não de banco de informações sobre cliente (cadastro atualizado 

e seu conteúdo).

Visão geral do empresário

Acrescentar uma análise geral do empresário sobre o relacionamento com o cliente e o 

andamento do negócio em geral.

Observações gerais:

•	 Sempre lembrar que o momento do briefing deve ser, preferencialmente, 

único. Evitar encontros repetitivos com o empresário.
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•	 Procurar identificar se existe na empresa um processo de coleta, tratamento e 

gerência das informações sobre o cliente (cadastro atualizado, banco de dados 

de compras do cliente) de forma automatizada.

•	 Lembrar que é a partir desta coleta de informações que será desenvolvido todo 

o processo de problematização do Projeto Aplicativo e consequentemente o 

seu prosseguimento.

•	 Um briefing bem feito é fundamental para o bom andamento do projeto, 

evitando interpretações erradas de informações, garantindo foco, objetividade 

e aplicabilidade imediata aos resultados alcançados.

•	 As especificidades do briefing devem ser alinhadas com o professor orientador 

antes de ser realizado. Há diferenças quando o público a ser pesquisado é 

interno ou externo à empresa.

•	 A existência de um modelo ou orientação de briefing não pressupõe igualdade 

de tratamento para empresas de realidades e culturas diferentes. Adaptações e 

adequações deverão ser realizadas para melhor atendimento às necessidades 

do Projeto Aplicativo. Os professores estão preparados para orientar a equipe 

de alunos sobre este tema.

Briefing publicitário (um modelo)

Introdução:

Qual o conceito do produto; qual o posicionamento e quais os alvos.

Antecedentes:

Histórico da marca; outras ações de comunicação.

Mercado (evolução, segmentação, posicionamento de produto; investimento).

Objetivos (market share; distribuição; vendas; comunicação).

Produto (nome; características; embalagem; preço; concorrência).

Ação:

Ações de comunicação publicitária ou não; orientação da agência; budget; timming.
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Contexto do Produto ou Serviço.

Descrição do produto; histórico da comunicação anterior da marca; descrição da 

concorrência;  análise de mercado; comportamento e atitudes dos consumidores e 

influenciadores.

Estratégia de Marketing.

Objetivos de marketing (volume de vendas e quota de mercado); posicionamento, 

segmentos alvos e fontes de mercado; mix de comunicação.

Plano do produto;

Produto e concorrência (marca produto; embalagem, preço e distribuição; consumo)

Objetivos (de mercado; de comunicação).

Grupo alvo, tempo, regionalização.

Mix de Comunicação:

Orçamento.

Meios, TV, Rádio, Imprensa, Outdoors; Cinema; Internet; Marketing Direto; Relações 

Públicas; Exposições; Promoções.

Perguntas facilitadoras:

Quem, A quem, O quê; Como.

Exercício número 4

PROPOSTA DE TRABALHO

Indica alguns dos conhecimentos básicos duma empresa para trabalhar o seu projeto 

e objetivo no mercado?
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Metodologia da criação gráfica

Conceção

Fase de definição de ideias, materiais e formatos a serem usados e dos detalhes que 

envolvem todo trabalho.

É nesta fase que todos os PORQUÊS e COMOS da campanha são determinados. Pensa-se 

antes para poupar trabalho depois.

Atendimento traz o briefing

Atendimento é a área da agência que faz o contacto direto com o cliente.

Briefing é a coleção de informações sobre a campanha, tais como, objetivos, público-

alvo, etc.

Reunião com pessoal de criação para passar o briefing (+ produção gráfica);

Todas as áreas da agência são envolvidas no projeto. É a forma de todos se comprometerem 

e trabalharem em conjunto.

Definição da linha de criação;

Qual será a linha adotada? Tradicional, Jovem, Impacto?

Objetivos do projeto;

Não importa a comunicação. Um objetivo tem que ser determinado:

Aumento de vendas, de lembrança do consumidor, etc.

Público alvo;

A quem se destina a comunicação. O público primário, aquele que receberá e entenderá 

a informação, o consumidor final.

Qual é a mensagem;

Normalmente, o que se quer dizer por trás do slogan é: Quero vender mais!

Como atingir o público alvo: revista, jornal, cartaz, etc.;

Através de pesquisa, deve ser determinado o melhor meio de se atingir o público alvo. 

De que maneira a comunicação será passada diretamente a esse público.

Quais os concorrentes do cliente e o que esses concorrentes tem feito;

O que o concorrente está falando a respeito do produto dele e o quanto isso afeta a 

comunicação do produto do cliente da agência? De que maneira a comunicação será feita, 
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de modo a anular os efeitos da comunicação do concorrente? Que tipo de comunicação 

fazer, para ficar diferente da do concorrente?

Brainstorm para elaboração de ideias;

O melhor meio de se determinar os rumos da campanha, a linha criativa, slogans, 

imagens, ideias básicas, etc.

Rough ou layout

O rough (lê-se ‘rafe’) é um rabisco inicial das ideias das peças publicitárias. O layout é 

uma versão melhorada do rough. Atualmente, com a facilidade do uso de computadores 

e da versatilidade dos softwares gráficos, o layout chega a ter qualidade de arte final.

Experimentação de vários layoutes; criação passa para o produtor gráfico os dados 

pretendidos para o material (formato, cores, tipo de papel, tipos de acabamento, etc.);

Com base nestas informações, começa-se a pesquisar os materiais que serão usados nas 

peças gráficas.

Atendimento passa para o produtor gráfico os outros dados para a produção do material 

(quantidade, prazo para a entrega do material, dados do cliente);

Com base nos dados fornecidos pela criação e pelo atendimento o produtor gráfico 

solicita orçamento dos fornecedores (fotolito, gráfica, fotos, revisores, etc.) e elabora o 

orçamento completo da agência para apresentar ao cliente;

O ideal é que já exista um arquivo com todos os bons fornecedores de todos nos materiais 

gráficos.

Com os orçamentos e o layout na mão o atendimento faz a apresentação da ideia ao 

cliente;

É o momento que o cliente vai ter uma ideia dos custos da campanha, dos rumos que o 

planeamento e a criação estão a tomar, etc.

Ideia e orçamento aprovados segue-se para a produção do material, em caso negativo 

trabalha-se em cima de outras ideias e/ou novos orçamentos, até a aprovação pelo 

cliente.

Caso o cliente não aprove a ideia, volta-se ao brainstorm para novas ideias e começa-se 

novamente a preparar novos layoutes, orçamentos, etc.
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Layout gráfico

Layout gráfico tem como seus componentes a área de design ou formato de página 

e as margens, que tal como em todo o restante processo de design deve ser bem 

fundamentado pelo conteúdo do trabalho e pela perspetiva criativa. Como e onde vai 

ser utilizado e visualizado o nosso layout, este deve ser efetuado tendo em conta vários 

sobrepostos.

O tamanho e o formato podem variar entre o de bolso e de parede, duas ou três 

dimensões. Ao desenvolver projetos de design para a web ou multimédia em que a área 

está predefinida, as proporções devem ser levadas em conta. Um designer no momento 

de iniciar um desenvolvimento de um trabalho necessita de fazer sempre primariamente 

um desenho da estrutura da página a elaborar, aqui deverá já conter informações como, 

largura do topo, margens inferiores e laterais (localizadas com objetivos de manutenção 

e condução do olhar), o número de colunas de texto, imagens e sua organização e, se for 

caso, o número de páginas ou a numeração das páginas. Com estas decisões já tomadas, 

a estrutura das páginas pode ser individual ou com páginas mestras, para permitir a 

repetição automática da estrutura já previamente estudada.

Estruturar o layout ao longo de uma série de páginas ou superfícies de modo a obter uma 

flexibilidade máxima sem perder a continuidade, é importante para manter a atenção do 

leitor. As proporções das margens vão variar de acordo com o contexto de design, mas 

como linha condutora, a margem inferior é normalmente o dobro da margem do topo e 

a margem inferior duplica a largura da margem exterior.

A maior parte do trabalho de design gráfico implica um número de tamanhos diferentes 

e elementos proporcionais que devem ser coordenados numa dada área.

ManualArtesGraficasEdicaoEletronicaMod5a8.indd   25 14-03-2014   17:45:10



26 | CURSO TÉCNICO DE ARTES GRÁFICAS

EDIÇÃO ELETRÓNICA

Digitalização

Digitalização é o processo pelo qual uma imagem ou sinal analógico é transformado em 

código digital. Isso se dá através de um equipamento e software digitalizador de imagens 

(ou scanner) ou de um transdutor de sinais.

A utilização de dispositivos eletrónicos, como os scanners, permitem que documentos 

originalmente em papel e materiais similares, filmes negativos e positivos, microfilmes 

e microfichas sejam convertidos em arquivos digitais, acessíveis em computador. Com 

isso, grandes volumes de informação documental podem ser armazenados em ambiente 

digital, o que permite serem disponibilizadas e reutilizadas, como, por exemplo, em um 

sistema de gestão Eletrónico e Documentos, conhecido como GED ou em bancos de 

imagens ou áudio.

A digitalização também compreende a conversão para o código digital de sinais de 

áudio e imagens em movimento (vídeos), originalmente em outros formatos como as 

gravações em discos fonográficos em vinil (sulcos) e em sinal eletromagnético analógico 

gravados em fios, fitas e discos magnéticos.

(scanner de digitalização de opacos e transparências)
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Provas digitais

As provas digitais podem definir-se como «todas aquelas provas que, tendo cor ou não, 

são realizadas a partir de um original digital».

Esta definição mesmo sendo correta é demasiado ampla e não permite nem delimitar 

as diferentes variedades das provas digitais nem mesmo as diferentes formas da sua 

utilização.

Por isso é importante distinguir as diferentes provas digitais e as suas áreas de aplicação:

•	 Provas de posicionamento;

•	 Provas de desenho;

•	 Provas de contrato;

•	 Provas de imposição.

Todas estas provas realizam uma função específica no mundo gráfico, devido à grande 

flexibilidade das mesmas, tem havido uma utilização incorreta das provas. É por este 

motivo que vamos tentar explicar que elementos se devem encontrar numa prova para 

que esta pertença a um determinado grupo e não a outro.

Provas de Posicionamento

As provas de posicionamento são as provas que se utilizam para verificar a posição dos 

elementos que formam uma página, isto é, são as provas que tentam manter o equilíbrio 

na página, quer a nível do grafismo, quer a nível do contragrafismo.

Estas provas podem ser realizadas por impressoras de toner que dão o aspeto geral da 

ideia pretendida. Os elementos que formam essa ideia não são definidos, podendo-se 

realizar várias provas até se encontrar a posição mais adequada para o objetivo desejado.

Provas de Desenho

As provas de desenho já contêm os elementos finais que se definiram nas provas de 

posicionamento. Nestas provas tanto se realizam correções ortográficas como de 
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conteúdo. Estas provas são normalmente realizadas por impressoras a cores que lhes 

dão um certo realismo. É de notar que a cor dessa impressão não será igual àquela que 

se obterá na impressão final nas artes gráficas. Estas provas não têm nenhum elemento 

que se possa utilizar como guia de impressão e a cor que possuem varia em cada prova.

Provas de Contrato

Estas provas são aquelas que têm a capacidade de mostrar todos os elementos da ideia 

original no final, na impressão nas artes gráficas, assim como conseguem incorporar 

elementos próprios que guiam o profissional de impressão.

Com estas provas realizam-se correções de cor, tanto nas cores de imagens como em 

cores diretas. Dadas as suas características são capazes de reproduzir todas as cores de 

uma imagem vezes sem conta, mostrando as mudanças efetuadas nessa imagem. Hoje 

em dia, a tecnologia que se utiliza para gerar estas provas é conhecida por CIJF. As tintas 

utilizadas nestas provas são tintas líquidas, cuja gama cromática é a base das tintas de 

impressão em artes gráficas.

Provas de Imposição

Estas provas mostram como fica a impressão depois de colada e cortada. As provas de 

imposição são realizadas com plotters que permitem imprimir sobre papel de grande 

formato, substituindo os conhecidos ozalides. Estas provas permitem ver se as páginas 

estão coladas na posição correta.

Exercício número 5

PROPOSTA DE TRABALHO

Distingue as diferentes provas digitais?
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Preparação para impressão de 
separações

Criação de separações

Para reproduzir imagens coloridas e de tonalidades contínuas, as impressoras geralmente 

separam a arte em quatro chapas — uma chapa para cada parte em ciano (C), magenta 

(M), amarelo (Y) e preto (K) da imagem. Quando recebem a tinta da cor apropriada e 

são impressas em registo umas com as outras, essas cores combinam-se para reproduzir 

a arte original. O processo de dividir a imagem em duas ou mais cores é denominado 

separação de cores, e os filmes dos quais as chapas são criadas são denominados 

separações.

Composto (esquerda) e separações (direita)

Processos de produção de separações

O Adobe InDesign CS4 suporta dois processos de produção comuns de PostScript.  

A principal diferença é onde as separações são criadas: no computador host (o sistema 
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que usa o InDesign e o driver de impressora) ou no RIP (processador de imagens 

rasterizadas) do dispositivo de saída. Outra alternativa é o processo de produção de PDF.

Separações baseadas no host

No processo de produção tradicional pré-separado baseado no host, o InDesign cria 

informações PostScript para cada separação necessária para o documento e as envia 

para o dispositivo de saída.

Separações In-Rip

No processo de produção baseado em RIP mais recente, uma nova geração de RIPs 

PostScript executa separações de cores, trapping e até gestão de cores no RIP, deixando o 

host livre para executar outras tarefas. Essa abordagem faz com que o InDesign leve menos 

tempo para gerar o arquivo e minimiza a quantidade de dados transmitidos para qualquer 

tarefa de impressão. Por exemplo, em vez de enviar informações PostScript para quatro ou 

mais páginas a fim de imprimir separações de cores baseadas no host, o InDesign as envia 

para um único arquivo PostScript composto para processamento no RIP.

Preparar o documento para separações de cores

1.	 Corrija quaisquer problemas de cores na arte.

2.	 Defina opções de superimposição.

3.	 Crie instruções de trapping para compensar erros de registo na impressora 

tipográfica.

4.	 Visualize as separações de cores na tela.

5.	 Nota: As etapas de 1 a 4 são recomendadas, mas não essenciais para produzir 

separações de cores.

6.	 Escolha ‘Arquivo’ > ‘Imprimir’, para exibir a caixa de diálogo ‘Imprimir’.

7.	 Se tiver criado uma predefinição de impressora com as configurações de 

separação apropriadas, selecione-a no menu ‘Predefinição de impressão’ na 

parte superior da caixa de diálogo ‘Imprimir’.
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8.	 Escolha uma impressora ou arquivo PostScript no menu ‘Impressora’.

9.	 Se estiver a imprimir num arquivo PostScript, escolha a PPD referente ao 

dispositivo que imprimirá as separações.

10.	Para exibir ou alterar opções de impressão existentes, clique num nome de 

secção no lado esquerdo da caixa de diálogo ‘Imprimir’.

11.	Antes de entregar o documento a um prestador de serviços, faça a prova das 

separações.

12.	Imprima ou salve as separações.

Saída de cores especiais

É possível usar tintas personalizadas, denominadas cores especiais, juntamente com as 

cores de escala ou no lugar delas. Por exemplo, em vez de usar as quatro cores de escala 

para reproduzir a arte com texto em preto e desenhos com linhas verdes azuladas, pode 

usar duas cores especiais — uma cor para o preto e outra representando o tom exato do 

verde. Pode usar tintas de cores especiais para criar cores que não sejam reproduzíveis 

por tintas CMYK, como cores fluorescentes e metálicas. Pode também misturar cores 

especiais, ou cores especiais com cores de escala para criar tintas mistas.

É possível colorir uma arte com cores de escala, cores especiais ou uma combinação de 

ambas. Ao imprimir separações, pode converter cores especiais nos seus equivalentes 

de cor de escala para que sejam impressas nas chapas CMYK.

Impressão de um composto

Pode imprimir uma prova composta em cores ou escala de cinza para ver as cores do 

documento. Uma imagem composta pode ajudá-lo a criar e fazer a prova do seu layout 

antes de imprimir separações finais (que são caras).

Quando o InDesign imprime um composto, ele imprime todas as cores utilizadas no 

arquivo em uma única chapa, não importando se foram selecionadas algumas cores 

individuais.
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Considere os seguintes problemas ao imprimir compostos:

Embora nenhuma prova forneça a representação exata da saída final, pode aumentar 

bastante a precisão por meio da calibragem de todos os dispositivos usados na criação de 

um documento (como scanners, monitores e impressoras). Se os dispositivos estiverem 

calibrados, o sistema de gestão de cores poderá ajudá-lo a obter cores previsíveis e 

uniformes.

As opções de superimposição selecionadas no documento serão impressas corretamente 

numa impressora que suporte a superimposição. Como a maioria das impressoras de 

mesa não suporta a superimposição, pode simular seus efeitos selecionando ‘Simular 

superimposição’ na seção ‘Saída’ da caixa de diálogo ‘Imprimir’.

Importante: A seleção de ‘Simular superimposição’ converterá cores especiais em cores 

de escala para impressão. Se desejar usar um arquivo para separações num RIP ou para 

saída final, não selecione esta opção.

Ao imprimir numa impressora em preto-e-branco, o InDesign produzirá uma versão 

composta de escala de cinza nas páginas. Se o documento contiver cores, o InDesign 

imprimirá cinzas visualmente corrigidos para simular essas cores. Por exemplo, o cinza 

que simula uma tonalidade de amarelo a 20% é mais claro do que uma tonalidade de 

20% de preto, pois o amarelo é mais claro que o preto.

Ao imprimir um livro com capítulos contendo estilos de trapping ou tintas especiais em 

conflito, é possível instruir o InDesign a sincronizar as configurações com o documento-

mestre.
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Apresentação

Neste módulo pretende-se criar o espaço para o desenvolvimento das aprendizagens 

da aplicação de desenho vetorial. Pretende-se aprofundar os conhecimentos sobre a 

construção e sobretudo a manipulação de objetos vetoriais.

Objetivos da aprendizagem 

Utilizar os conhecimentos relativos à construção de objetos vetoriais;

Converter imagens bitmap em objetos vetoriais;

Construir diferentes tipos de gráficos e pictogramas;

Aplicar as técnicas de manipulação de vetores;

Utilizar as ferramentas de extrusão;

Criar e utilizar padrões e esfumados.

Âmbito dos conteúdos

Desenho;

Vetorização de imagens de bits no modo automático;

Construção de gráficos e pictogramas;

Edição de objetos;

Rasterização de gráficos de vetores;

Transformação e distorção de objetos;

Junção de caminhos;

Utilização da ferramenta mask em gráficos e imagens bitmaps;

Expansão de um caminho e construção de contorno;

Construção de formas análogas por expansão ou contração;

Fusão de objetos diferentes;

Adição de efeitos especiais aos objetos;

Transformação de objetos;

Distorção de objetos;

Construção de perspetivas;
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Cor, contorno e preenchimento;

Esbatidos e padrões;

Exportação da paleta de cores.
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Imagem Vetorial x Imagem Bitmap 
(Raster)

Para compreender as diferenças entre imagens vetoriais e imagens bitmaps, vamos 

transportá-lo à escola...

Lembra-se de quando estudou ciências na escola, e lhe foi apresentado o átomo? Na 

verdade, via um átomo, ele é de facto como foi descrito. Por outro lado, foi apresentado 

um modelo, um “faz de conta” que, apesar de não ser o átomo de verdade, permitiu 

que compreendesse e pudesse trabalhar com átomos. De modo análogo, explicaremos 

a diferença entre imagens vetoriais e imagens bitmap, e programas que trabalham 

com imagens vetoriais e programas que trabalham com imagens bitmaps (mapas de 

bits). O que vamos exemplificar não é a realidade absoluta (precisaria de um bocado de 

matemática), mas demonstra claramente a diferença entre os dois sistemas.

Imagem vetorial

Como na física, onde um vetor é uma entidade definida pelos atributos direção, módulo 

e sentido, podemos dizer que, na comunicação visual, os vetores (imagens vetoriais) são 

objetos definidos, também, pelos seus atributos.

Assim, de modo simplificado, o objeto abaixo (imagem vetorial) poderia ser definido da 

seguinte maneira:

•	 Tipo de Curva = Circunferência

•	 Raio = 1 cm

•	 Preenchimento = amarelo

•	 Contorno = azul
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Observe que, para guardar esse círculo, não precisamos gravar a imagem propriamente 

dita, que seriam os pixels (gastaria muita memória).

Se guardarmos os atributos, como “Circunferência”, preenchida de “amarelo”, contornada 

por “azul” e com raio de “1 cm”, qualquer computador poderia reproduzi-la! Esta é a 

principal característica de uma imagem vetorial.

Cada vez que o Illustrator (ou outro software vetorial como CorelDRAW, ou o PowerPoint, 

por exemplo) for carregar uma imagem vetorial, ele lerá, do disco, os atributos e 

REDESENHARÁ a imagem, claro, obtendo uma idêntica à original!

Ainda, pensando nessa linha, se decidíssemos aumentar o raio para 3 cm, apesar de 

gastarmos mais espaço de tela, não gastaríamos mais espaço no disco. Afinal, o círculo 

(os pixels que o compõem) não será gravado no disco. Apenas os atributos!

•	 Tipo de Curva = Circunferência

•	 Raio = 3 cm

•	 Preenchimento = amarelo

•	 Contorno = azul

Imagem Bitmap ou Imagem Raster (Mapa de Bits)

Imagem Bitmap pixel a pixel. Uma fotografia digitalizada é um exemplo claro de imagem 

bitmap. Dificilmente terá o mesmo efeito apenas com objetos vetoriais. Por isso, o 
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CorelDRAW (e outros do género), que é um programa vetorial, aceita a importação 

de imagens bitmaps, de modo a que possa criar trabalhos misturando os dois tipos de 

imagens (bitmap e vetorial).

Claro que o CorelDRAW não trabalha estas imagens do mesmo modo que programas 

específicos o fazem, como o Corel Photo-Paint, o Photoshop e o próprio Paint do 

Windows.

Bitmaps são imagens que, apresentadas no monitor, são divididas em pequenos 

quadradinhos, cada um, com uma cor. Esses quadradinhos chamam-se pixels. Quando 

se grava na modalidade bitmap, grava-se o conteúdo de cada pixel. Num programa que 

manipula bitmaps, como o Paint do Windows ou o Photoshop, pode alterar a cor até 

mesmo de um único pixel!

Apesar das vantagens para se trabalhar com fotos, ícones, ou outros desenhos, existem 

algumas desvantagens para os arquivos do tipo bitmap.

Redimensionamento do bitmap

O sistema perde quando precisamos redimensionar imagens. Como os pixels não são 

redimensionáveis, perdemos pixels ao reduzirmos o tamanho da imagem. De modo 

oposto, ao ampliarmos uma imagem bitmap, são acrescentados pixels (o programa 

INVENTA os pixels que são acrescentados). Por isso, por mais sofisticada que seja 

a interpolação de pixels, imagens bitmaps com tamanho alterado não apresentam 

qualidade muito boa, especialmente, quando ampliamos.

No armazenamento em disco

Imagine o quanto se consome de disco, numa circunferência com raio de 30 cm, se 

tivéssemos que armazená-la conforme o exemplo seguinte:
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Quadrado da linha 01, coluna 01 = branco

Quadrado da linha 01, coluna 01 = branco

Quadrado da linha 18, coluna 12 = azul

Quadrado da linha 18, coluna 12 = amarelo

Quadrado da linha 18, coluna 12 = amarelo

Exemplo de ampliação de uma Imagem Vetorial

Observe como fica perfeita a ampliação de uma imagem vetorial. O lápis foi construído 

(e ampliado) num programa de vetores (CorelDRAW) e não tem o acabamento de uma 

foto.

Exemplo de ampliação de uma Imagem Bitmap

Um bitmap pode conter muito mais detalhes e parecer perfeito. No entanto, ao 

redimensionarmos, poderemos ter perda de qualidade. Na figura, o lápis menor é um 

bitmap obtido de um desenho vetorial (original). Ao ampliar a o lápis num programa 

bitmap, como o Paint, por exemplo, note que a qualidade do resultado vai diminuindo.
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De Vetor para Bitmap

Como Rasterizar Imagens

Imagem Vetorial Rasterizada, chamamos de rasterização ao processo de transformação 

de uma imagem vetorial em uma imagem bitmap, também conhecida como raster. Neste 

caso, teremos uma imagem rasterizada.

Em geral, isto é possível importando imagens, originalmente vetoriais, em programas 

que trabalham com imagens bitmap.

O Photoshop permite esse processo e, provavelmente, utilizará muitas vezes, como, por 

exemplo, para apresentar logótipos (usualmente concebidos como vetor) em páginas de 

internet, como imagem jpg, gif ou png.

Os programas que trabalham com vetores, como o CorelDRAW, o InDesign e o Illustrator, 

também costumam permitir a exportação para bitmap.

Exemplo: a imagem em baixo é uma estilização em linha produzida no Illustrator e, poste-

riormente, rasterizada, ou seja, transformada em imagem bitmap. Aqui, no formato .png.
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De Bitmap para Vetor

Como Vetorizar Imagens

Existem aplicativos, como o Vector Magic e o Magnigraph, que vetorizam automaticamente 

uma imagem bitmap, transformando-a em vetor por um processo conhecido como auto-

tracing. Funciona bem, em especial para elementos com contornos bem definidos.

Os Designers, no entanto, trabalham muito com o que chamamos de vetorização manual. 

Como que decalcando um desenho (quando coloca uma transparência sobre a imagem 

original e desenha uma nova) e utilizando ferramentas adequadas de programas como o 

Illustrator ou o CorelDRAW, obtém-se uma imagem vetorizada mais perfeita e detalhada. 

Com este processo, pode tanto obter uma ilustração realista (onde imagem vetorizada 

e imagem bitmap parecem idênticas), ou uma simplificação (ilustração estilizada), como 

o morango da figura.

Uma tarefa comum para designers é a vetorização de logos antigos, cuja digitalização 

produziu um bitmap. Transformando o logo antigo em vetor, temos a possibilidade 

de redimensioná-lo sempre com perfeição, além de poder aplicá-lo nos mais diversos 

materiais. Claro, recomenda-se que os logos novos sejam concebidos com programas 

vetoriais (após, é claro, uma série de rafes à mão).
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Vetor por Observação

Os Designers também costumam desenhar a partir da observação de um objeto real. Esse 

desenho pode ser feito com lápis e papel e depois digitalizado e vetorizado (Illustrator 

ou CorelDRAW) ou diretamente desenhado dentro do Illustrator ou CorelDRAW com o 

auxílio de uma Tablet (pequena mesa digitalizadora).

Exemplo: lápis desenhado no InDesign com a ferramenta Pen (sem tablet).

Exercício número 1

PROPOSTA DE TRABALHO

O que entendes por bitmap?

Exercício número 2

PROPOSTA DE TRABALHO

Indica dois programas que trabalhem com vetores?
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Sobre imagens de bitmap

Imagens de bitmap, tecnicamente chamadas de imagens de varredura, usam uma grade 

retangular de elementos de figura (pixels) para representar imagens. É atribuído a cada 

pixel um local específico e um valor de cor. Ao trabalhar com imagens de bitmap, você 

edita pixels em vez de objetos ou formas. Imagens de bitmap são o meio eletrónico mais 

comum para imagens de tons contínuos, como fotografias ou pinturas digitais, porque 

podem representar gradações subtis de sombras e cores com mais eficiência.

As imagens de bitmap dependem da resolução, isto é, elas contêm um número fixo 

de pixels. Como resultado, elas podem perder detalhes e ter uma aparência irregular 

se forem redimensionadas numa ampliação alta na tela ou se forem impressas numa 

resolução mais baixa do que aquela em que foram criadas.

Exemplo de uma imagem de bitmap em diferentes níveis de ampliação

As imagens de bitmap podem exigir grandes quantidades de espaço de armazenamento 

e, geralmente, precisam ser compactadas para reduzir o tamanho dos arquivos em 

determinados componentes do Creative Suite. Por exemplo, compacta um arquivo de 

imagem no seu aplicativo original antes de importá-lo para um layout.

Diretrizes de resolução da imagem para saída final

As imagens de bitmap contêm um número fixo de pixels, que geralmente são medidos 

em pixels por polegada (ppi). Uma imagem de alta resolução contém mais pixels (e, 

portanto, pixels menores) em comparação a uma imagem com as mesmas dimensões 
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impressas de baixa resolução. Por exemplo, uma imagem de 1 por 1 polegada com uma 

resolução de 72 ppi contém um total de 5184 pixels (72 pixels de largura x 72 pixels de 

altura = 5184). A mesma imagem de 1 por 1 polegada com uma resolução de 300 ppi 

conteria um total de 90.000 pixels.

Em imagens de bitmap importadas, a resolução da imagem é determinada pelo arquivo 

de origem. Em efeitos de bitmap, é possível especificar uma resolução personalizada. 

Para determinar a resolução de imagem a ser usada, considere a média de distribuição 

final para a imagem. As seguintes instruções podem ajudá-lo a determinar seus requisitos 

para a resolução da imagem:

Impressão comercial

A impressão comercial requer imagens de 150 a 300 ppi (ou mais), dependendo da 

impressão (dpi) e frequência de tela (lpi) que estiver a ser usada; consulte sempre o 

provedor de serviços de pré-impressão antes de tomar decisões de produção. Uma vez 

que a impressão comercial requer imagens grandes, de alta resolução, que levam mais 

tempo para exibir enquanto estiver a trabalhar com elas, convém usar as versões de 

baixa resolução para layout e, em seguida, substituí-las por versões de alta resolução na 

fase de impressão.

No Illustrator e InDesign, é possível trabalhar com versões de baixa resolução usando 

o painel Vínculos. No InDesign, pode escolher as opções Típico ou Exibição Rápida no 

menu Visualizar > Exibir desempenho; no Illustrator, pode escolher Visualizar > Contorno. 

Como alternativa, se o seu provedor de serviços oferece suporte ao Interface de Pré-

impressão Aberta (OPI), é possível que ele forneça imagens de baixa resolução.

Impressão em desktop

As impressões em desktop geralmente exigem imagens no intervalo de 72 ppi (para 

fotografias impressas numa impressora de 300 ppi) a 150 ppi (para fotografias impressas 

em dispositivos de até 1000 ppi). Em arte vetorial (imagens de 1 bit), verifique se a 

resolução dos seus gráficos corresponde à resolução da impressora.
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Edição na Web

Uma vez que a edição on-line geralmente requer imagens com dimensões em pixel que 

se ajustam ao monitor destinado, as imagens normalmente têm menos de 500 pixels 

de largura e 400 pixels de altura, para deixar espaço para os controles de janela do 

navegador ou para tais elementos de layout como legendas. A criação de uma imagem 

original na resolução de tela (96 ppi para imagens do Windows e 72 ppi para imagens do 

Mac OS) permite que você veja a imagem como ela provavelmente aparecerá quando 

visualizada em um navegador da Web comum. Durante a edição on-line, as únicas 

ocasiões em que pode precisar de resoluções acima desses intervalos é quando desejar 

que os utilizadores possam aplicar mais zoom para obter mais detalhes num documento 

PDF, ou quando estiver a produzir um documento para impressão sob demanda.

Exercício número 3

PROPOSTA DE TRABALHO

Para uma impressão comercial qual a resolução mínima requerida?

Exercício número 4

PROPOSTA DE TRABALHO

As imagens bitmap geralmente podem exigir grande capacidade de armazenamento 

no computador? Verdadeiro ou Falso.
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Ferramenta extrusão interativa no 
CorelDraw

O CorelDraw é um programa que nos permite fazer coisas incríveis e as imagens vetoriais 

são o seu forte, pois, ao contrário de outros programas, ele permite a edição dessas 

imagens por pontos específicos, os nós. Uma ferramenta muito interessante é a Extrusão 

Interativa que permite transformar as suas imagens vetoriais numa espécie de 3D. Veja 

nesse tutorial de como usar a Extrusão Interativa no CorelDraw.

Para começar abra o CorelDraw e para fazer o teste pode simplesmente escrever uma 

palavra ou usar uma das formas que o programa disponibiliza. É interessante deixar o 

texto ou figura num tamanho razoavelmente grande para poder ver melhor o efeito que 

a ferramenta terá.

Com a imagem selecionada deverá ir até as ferramentas que ficam posicionadas na 

caixa de tools, em geral à direita. Escolha o menu mistura e nele a ferramenta Extrusão 

Interativa.

Como na imagem abaixo.

Perceba que sobre a sua imagem se formou um tipo de quadrado com um ponto no 

centro. Manipulando a linha pontilhada é possível controlar o quanto a imagem terá 

a ideia de profundidade, pode deixar totalmente em 3D ou apenas com um pouco de 

volume. Veja o exemplo abaixo.
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E como toda ferramenta do CorelDraw a Extrusão também abre um menu específico 

na barra acima dessa forma existem opções especiais para complementar o uso dessa 

ferramenta. Para dar mais realismo à ideia de 3D pode usar a opção Extrusão Rotativa 

que está nesse menu acima. Aparecerá um número 3 quando selecionar essa opção, 

rode como gostaria de visualizar a rotação da imagem. Veja na imagem abaixo.

E o resultado final…
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Desenho

Sobre os gráficos vetoriais

Os gráficos vetoriais (às vezes chamados de formas vetoriais ou objetos vetoriais) são 

compostos de linhas e curvas definidas por objetos matemáticos chamados de vetores, 

que descrevem uma imagem de acordo com suas características geométricas.

É possível mover ou modificar gráficos vetoriais livremente sem perda de detalhes ou 

clareza, porque eles não dependem da resolução — eles mantêm arestas bem definidas 

ao serem redimensionados, impressos numa impressora PostScript, salvos num arquivo 

PDF ou importados para um aplicativo de imagens gráficas baseado em vetores. Como 

resultado, os gráficos vetoriais são a melhor opção para arte-final, como logótipos, que 

serão usados em diversos tamanhos e em vários suportes de saída.

Os objetos vetoriais que cria ao usar as ferramentas de desenho e forma no Adobe 

Creative Suite são exemplos de gráficos vetoriais. É possível usar os comandos Copiar e 

Colar para duplicar gráficos vetoriais entre componentes do Creative Suite.

Sobre demarcadores

À medida que se desenha, uma linha chamada demarcador é criada. Um demarcador é 

composto de um ou mais segmentos retos ou curvados. O início e o fim de cada segmento 

é marcado por pontos de ancoragem, que funcionam como pinos mantendo um arame 

no lugar. Um demarcador pode ser fechado (por exemplo, um círculo) ou aberto, com 

extremidades distintas (por exemplo, uma linha ondulada).
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É possível alterar a forma de um demarcador arrastando os pontos de ancoragem, os 

pontos de direção no final das linhas de direção que aparecem em pontos de ancoragem, 

ou o próprio segmento de demarcador.

Componentes de um demarcador

A. Extremidade selecionada (sólida)

B. Ponto de ancoragem selecionado

C. Ponto de ancoragem não selecionado

D. Segmento de demarcador curvado

E. Linha de direção

F. Ponto de direção

Os demarcadores podem ter dois tipos de pontos de ancoragem: pontos de vértice e pontos 

suaves. Num ponto de vértice, o demarcador muda repentinamente de direção. Num 

ponto suave, os segmentos do demarcador são conectados como uma curva contínua. É 

possível desenhar um demarcador usando qualquer combinação de pontos de vértice e 

pontos suaves. Se desenhar o tipo errado de ponto, é sempre possível alterá-lo.

Pontos em um demarcador

A. Quatro pontos de vértice

B. Quatro pontos suaves

C. Combinação de pontos de vértice e pontos suaves
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Um ponto de vértice pode conectar dois segmentos retos ou curvados, enquanto um 

ponto suave conecta sempre dois segmentos curvados.

Um ponto de vértice pode conectar tanto os segmentos retos como os curvados.

O contorno de um demarcador é chamado de traçado. Uma cor ou um degradê aplicados 

a uma área interior aberta ou fechada do demarcador são chamados de preenchimento. 

Um traçado pode ter espessura, cor e um padrão de traço (Illustrator e InDesign), ou um 

padrão de linha estilizado (InDesign). Após criar um demarcador ou uma forma, pode 

alterar as características do seu traçado e preenchimento.

No InDesign, cada demarcador exibe também um ponto central, que marca o centro da 

forma, mas não faz parte do demarcador em si. Pode usar esse ponto para arrastar o 

demarcador, para alinhar o demarcador a outros elementos ou para selecionar todos os 

pontos de ancoragem no demarcador. O ponto central está sempre visível; ele não pode 

ser ocultado ou excluído.

Sobre linhas de direção e pontos de direção

Quando seleciona um ponto de ancoragem que conecta segmentos curvados (ou 

seleciona o próprio segmento), os pontos de ancoragem dos segmentos de conexão 

exibem alças de direção, que consistem em linhas de direção que finalizam em ponto 

de direção. O ângulo e o comprimento das linhas de direção determinam a forma e o 

tamanho dos segmentos curvados. A movimentação dos pontos de direção remodela as 

curvas. As linhas de direção não aparecem na saída final.
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Após selecionar um ponto de ancoragem (à esquerda), as linhas de direção aparecem 

em quaisquer segmentos curvados conectados pelo ponto de ancoragem (à direita).

Um ponto suave tem sempre duas linhas de direção, que se movem juntas como 

uma unidade única e reta. Quando uma linha de direção é movida num ponto suave, 

os segmentos curvados de ambos os lados do ponto se ajustam simultaneamente, 

mantendo uma curva contínua naquele ponto de ancoragem.

Em comparação, um ponto de vértice pode ter duas, uma ou nenhuma linha de direção, 

dependendo se ela junta dois, um ou nenhum segmento curvado, respetivamente. As 

linhas de direção do ponto de vértice mantêm o vértice usando ângulos diferentes. Ao 

mover uma linha de direção num ponto de vértice, só é ajustada a curva do mesmo lado 

do ponto que a linha de direção.

Ajuste de linhas de direção num ponto suave (à esquerda) e em ponto de vértice  

(à direita)
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As linhas de direção são sempre tangentes (perpendicular ao raio de) à curva nos pontos 

de ancoragem. O ângulo de cada linha de direção determina a inclinação da curva, e o 

comprimento de cada linha de direção determina a altura, ou profundidade, da curva.

Mover e redimensionar as linhas de direção altera a inclinação das curvas.

ManualArtesGraficasEdicaoEletronicaMod5a8.indd   54 14-03-2014   17:45:20



Manual do Aluno

CURSO TÉCNICO DE  ARTES GRÁFICAS | 55

Sobre símbolos

Um símbolo é um objeto artístico que pode ser reutilizado num documento. Por exemplo, 

se criar um símbolo a partir de uma flor, poderá adicionar instâncias desse símbolo várias 

vezes ao seu trabalho artístico sem adicionar realmente a arte complexa várias vezes. 

Cada instância de símbolo é vinculada ao símbolo no painel Símbolos ou a uma biblioteca 

de símbolos. O uso de símbolos pode poupar tempo e reduzir significativamente o 

tamanho do arquivo.

Os símbolos também fornecem um excelente suporte para exportação SWF e SVG. Ao 

exportar para o Flash, pode definir o tipo de símbolo como Clipe de filme. Ao aceder 

ao Flash, será possível escolher tipo, se necessário. Também pode especificar a escala 

de 9 fatias no Illustrator, para que os símbolos sejam dimensionados apropriadamente 

quando usados para componentes da interface do usuário.

Trabalho artístico com instâncias de símbolo
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Inserir um símbolo

Selecione um símbolo no painel Símbolos ou numa biblioteca de símbolos.

Siga um destes procedimentos:

Clique no botão Place Symbol Instance no Painel Símbolos para inserir a instância no 

centro da área visível atual da janela do documento.

Arraste o símbolo até a prancheta, no local em que deseja exibi-lo.

Selecione Inserir instância de símbolo, no menu do painel Símbolos.

Nota: Um único símbolo inserido em qualquer local do trabalho artístico (ao contrário de 

existir apenas no painel) é chamado de uma instância.

Criar um símbolo

Selecione o trabalho artístico a ser usado como símbolo.

Siga um destes procedimentos:

Clique no botão Novo símbolo , no painel Símbolos.

Arraste o trabalho artístico até o painel Símbolos.

Selecione Novo símbolo, no menu do painel.

Nota: Por padrão, o trabalho artístico selecionado torna-se uma instância do novo 

símbolo. Se não quiser que o trabalho artístico se torne uma instância, pressione Shift ao 

criar o novo símbolo. Além disso, se não quiser que a caixa de diálogo Novo símbolo seja 

aberta quando um novo símbolo for criado, pressione a tecla Alt (Windows), ou Option 

(Mac OS), enquanto cria o símbolo, e o Illustrator usará um nome padrão para ele, como 

Novo símbolo 1.

Na caixa de diálogo Opções de símbolo, digite um nome para o símbolo.

Selecione o tipo de símbolo como Clipe de filme ou Gráfico. Se planeia exportar os 

símbolos para o Flash, faça o seguinte:

Selecione Clipe de filme para o tipo. Clipe de filme é o tipo de símbolo padrão no Flash 

e no Illustrator.

Na grade de Registo, especifique um local desejado para definir o ponto âncora do 

símbolo. O local do ponto âncora afeta a posição do símbolo nas coordenadas da tela.
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Selecione Ativar guias para escala de 9 fatias, se quiser utilizar a escala de 9 fatias no 

Flash.

Selecione a opção Alinhar à grade de pixels para aplicar ao símbolo a propriedade de 

alinhamento de pixels. Para obter mais informações, consulte Alinhamento de símbolos 

à grade de pixels.

Pode criar símbolos a partir da maioria dos objetos do Illustrator, incluindo caminhos, 

caminhos compostos, objetos de texto, imagens rasterizadas, objetos de malha e grupos 

de objetos. Entretanto, não pode criar um símbolo a partir de uma arte vinculada ou de 

alguns grupos, como grupos de gráficos.
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Seleção de cores

É possível selecionar cores para um trabalho artístico a partir de várias ferramentas, painéis 

e caixas de diálogo no Illustrator. A forma de seleção das cores depende das necessidades 

do trabalho artístico em questão. Por exemplo, se deseja usar cores específicas aprovadas 

pela sua empresa, convém selecionar cores na biblioteca de amostras aprovada pela 

empresa. Se deseja corresponder as suas cores com as cores noutro trabalho artístico, use 

o conta-gotas ou o Seletor de cores e insira valores de cor exatos.

É possível usar qualquer um dos recursos a seguir para selecionar cores:

Painel Amostras e painéis de bibliotecas de amostras

Fornecem cores individuais e grupos de cores. Pode escolher entre amostras e bibliotecas 

existentes ou criar as suas próprias versões desses itens. Também é possível importar 

bibliotecas.

Seletor de cores

Fornece um espectro de cores a partir do qual é possível fazer a seleção visual de cores, 

além de conter caixas de texto de valores de cor para a definição manual de cores e 

amostras de cores.

Ferramenta Conta-gotas

Obtém amostras de cores a partir de um trabalho artístico quando clica nele.

Painel Cor

Fornece um espectro de cores, seletores de cor individuais (como um seletor de Ciano) e 

caixas de texto de valores de cor. É possível especificar cores de preenchimento e traçado 

no painel Cor. No menu do painel Cor, pode criar cores inversas e complementares para 

a cor de preenchimento ou traçado atual, além de criar uma amostra a partir da cor 

selecionada.
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Painel Guia de cores

Fornece várias regras de harmonia que podem ser escolhidas para a criação de grupos 

de cores, usando uma cor base selecionada por si. É possível criar variações de cores 

usando tons e graduações de co, cores quentes ou frias ou cores vivas e brandas. Nesse 

painel, pode abrir um grupo de cores na caixa de diálogo Editar cores/Recolorir arte.

Caixa de diálogo Editar cores/Recolorir arte

Parte dessa caixa de diálogo fornece ferramentas para definir ou ajustar com precisão as 

cores em um grupo de cores ou num trabalho artístico. A outra parte permite recolorir 

o trabalho artístico com as cores de um grupo de cores ou reduzir ou converter as suas 

cores para saída.

Comando Adicionar cores selecionadas ou botão Novo  
grupo de cores

Crie um grupo de cores contendo as cores no trabalho artístico selecionado. Esse 

comando e esse botão estão ambos localizados no painel Amostras.

Visão geral do Seletor de cores

Com o Seletor de cores, 

pode selecionar a cor 

de preenchimento ou 

traçado de um objecto, 

escolhendo um espec-

tro e um campo de cor, 

definindo cores nume-

ricamente ou clicando 

em uma amostra.
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A. Campo de cor

B. Valores de cor HSB

C. Novo retângulo de cor

D. Retângulo de cor original

E. Seletor de cor

F. Espectro de cores

G. Valores de cor RGB

H. Valor de cor hexadecimal

I. Valores de cor CMYK

Visão geral do painel Cor

Use o painel Cor (Janela > Cor) para aplicar cor ao preenchimento e ao traçado de um 

objeto e também para editar e misturar cores. O painel Cor pode exibir valores de cor 

usando diferentes modelos de cores. Por padrão, apenas as opções utilizadas com mais 

frequência são visíveis no painel Cor.

A. Cor de preenchimento

B. Cor do traçado

C. Menu do painel

D. Caixa Nenhum

E. Barra do espectro de cores

F. Seletor de cor

G. Caixa de texto para um componente de cor
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Desenho com a ferramenta Caneta

Desenho de segmentos de linha reta com a ferramenta  
Caneta

O demarcador mais simples que pode desenhar com a ferramenta Caneta é uma linha 

reta, feita com a seleção da ferramenta Caneta para criar dois pontos de ancoragem. 

Se continuar a clicar, criará um demarcador composto de segmentos de linha reta 

conectados por pontos de vértice.

Clicar na ferramenta Caneta cria segmentos retos.

 Selecione a ferramenta Caneta.

Posicione a ferramenta Caneta no local de início do segmento reto e clique para definir 

o primeiro ponto de ancoragem (não arraste).

Clique novamente onde deseja que o segmento termine (clique com a tecla Shift 

pressionada para restringir o ângulo do segmento a um múltiplo de 45°).

Continue a clicar para definir pontos de ancoragem para segmentos retos adicionais.

O último ponto de ancoragem a ser adicionado sempre é um quadrado sólido, indicando 

que ele está selecionado. Os pontos de ancoragem anteriormente definidos tornam-se 

vazados e desmarcados conforme mais pontos de ancoragem são adicionados.

 Complete o demarcador executando um dos seguintes procedimentos:

Para fechar o demarcador, posicione a ferramenta Caneta sobre o primeiro ponto de an-

coragem (vazio). Um pequeno círculo aparecerá junto ao ponteiro da ferramenta Caneta 

quando ela estiver posicionada corretamente. Clique ou arraste para fechar o demarcador.
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Para deixar o demarcador aberto, clique em qualquer lugar longe de todos os objetos 

com a tecla Ctrl (Windows) ou Command (Mac OS) pressionada.

Para deixar o demarcador aberto, você também pode selecionar uma ferramenta 

diferente ou escolher Selecionar > Cancelar seleção no Illustrator, ou Editar > Cancelar 

todas as seleções no InDesign. No InDesign ou no Illustrator, você também pode 

pressionar Enter ou Return para sair de um caminho aberto.

Desenho de curvas com a ferramenta Caneta

Crie uma curva adicionando um ponto de ancoragem onde uma curva muda de direção 

e arrastando as linhas de direção que formam a curva. O comprimento e a inclinação das 

linhas de direção determinam a forma da curva.

As curvas são mais fáceis de serem editadas e seu sistema pode exibi-las e imprimi-las 

mais rápido se elas forem desenhadas usando o menor número de pontos de ancoragem 

possível. O uso de muitos pontos também pode gerar saliências indesejadas numa curva. 

Em vez disso, desenhe pontos de ancoragem bem espaçados e pratique a formatação 

das curvas ajustando o comprimento e os ângulos das linhas de direção.

Selecione a ferramenta Caneta.

Posicione a ferramenta Caneta no local de início da curva e mantenha o botão do rato 

pressionado.

O primeiro ponto de ancoragem aparece e o ponteiro da ferramenta Caneta muda para 

uma seta. (No Photoshop, o ponteiro muda apenas depois que tiver começado a arrastar.)

Arraste para definir a inclinação do segmento curvado que estiver a criar e, em seguida, 

solte o botão do rato.

Em geral, estenda a linha de direção a um terço da distância do próximo ponto de 

ancoragem que planeia desenhar. (É possível ajustar posteriormente um dos lados da 

linha de direção ou ambos.)

Pressione a tecla Shift para restringir a ferramenta a múltiplos de 45°.
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Desenho do primeiro ponto numa curva

A. Posicionamento da ferramenta Caneta

B. Começando a arrastar (botão do rato pressionado)

C. Arrastando para estender as linhas de direção

Posicione a ferramenta Caneta no local em que deseja que o segmento curvado termine 

e execute um dos procedimentos a seguir:

Para criar uma curva em forma de C, arraste em uma direção oposta à linha de direção 

anterior. Em seguida, solte o botão do rato.

Desenho do segundo ponto numa curva

A. Começando a arrastar o segundo ponto suave

B. Arrastando longe da linha de direção anterior, criando uma curva C

C. Resultado após soltar o botão do rato
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Para criar uma curva em forma de S, arraste na mesma direção da linha de direção 

anterior. Em seguida, solte o botão do rato.

Desenho de uma curva S

A.  Começando a arrastar o novo ponto suave

B. Arrastando na mesma direção da linha de direção anterior, criando uma curva S

C. Resultado após soltar o botão do rato

Desenho de linhas retas seguidas de curvas

Usando a ferramenta Caneta, clique nos pontos de vértice em dois locais para criar um 

segmento reto.

Posicione a ferramenta Caneta sobre a extremidade selecionada. No Illustrator e 

InDesign, um ícone de conversão de pontos aparece ao lado da ferramenta Caneta 

quando ela está posicionada corretamente (no Photoshop, uma pequena linha diagonal, 

ou barra, aparece ao lado da ferramenta Caneta). Para definir a inclinação do segmento 

curvado que será criado a seguir, clique no ponto de ancoragem e arraste a linha de 

direção exibida.

ManualArtesGraficasEdicaoEletronicaMod5a8.indd   64 14-03-2014   17:45:23



Manual do Aluno

CURSO TÉCNICO DE  ARTES GRÁFICAS | 65

Desenho de um segmento reto seguido por um segmento curvado (parte 1)

A. Segmento reto concluído

B. Posicionando a ferramenta Caneta sobre a extremidade (o ícone Converter Pontos 

aparece somente no Illustrator e no InDesign)

C. Arrastando o ponto de direção

Posicione a caneta onde deseja colocar o próximo ponto de ancoragem; em seguida, 

clique (e arraste, se desejado) o novo ponto de ancoragem para completar a curva.

Desenho de um segmento reto seguido por um segmento curvado (parte 2)

A. Posicionamento da ferramenta Caneta

B. Arrastando a linha de direção

C. Novo segmento curvado concluído
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Desenho de curvas seguidas de linhas retas

Usando a ferramenta Caneta, arraste para criar o primeiro ponto suave do segmento 

curvo, e solte o botão do rato.

Reposicione a ferramenta Caneta no local em que deseja que o segmento curvo termine; 

arraste para completar a curva e solte o botão do rato.

Desenho de um 

segmento curvado 

seguido por um 

segmento reto (parte 1)

A. Primeiro ponto suave do segmento curvado concluído e a ferramenta Caneta 

posicionada sobre a extremidade

B. Arrastando para completar a curva

Posicione a ferramenta Caneta sobre a extremidade selecionada. Quando ela estiver 

posicionada corretamente, um ícone de conversão de pontos aparecerá junto à ferramenta. 

Clique no ponto de ancoragem para converter o ponto suave num ponto de vértice.

Reposicione a ferramenta Caneta no local em que deseja que o segmento reto termine, 

e clique para concluir o segmento reto.

Desenho de um 

segmento curvado 

seguido por um 

segmento reto (parte 2)

C. Posicionando a ferramenta Caneta sobre uma extremidade existente

D. Clicando na extremidade

E. Clicando no próximo ponto de vértice
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Desenho de dois segmentos curvados conectados por um 
vértice

Usando a ferramenta Caneta, arraste para criar o primeiro ponto suave de um segmento 

curvado.

Reposicione a ferramenta Caneta e arraste para criar uma curva com um segundo ponto 

suave; em seguida, mantenha pressionada a tecla Alt (Windows) ou Option (Mac OS) e 

arraste a linha de direção na direção da extremidade oposta para definir a inclinação da 

próxima curva. Solte a tecla e o botão do rato.

Esse processo converte o ponto suave num ponto de vértice dividindo as linhas de 

direção.

Reposicione a ferramenta Caneta no local em que deseja que o segundo segmento 

curvado termine, e arraste um novo ponto suave para concluir o segundo segmento 

curvado.

Desenho de duas curvas

A. Arrastando um novo ponto suave

B. Pressionando Alt/Option para dividir as linhas de direção enquanto arrasta e 

oscilando a linha de direção para cima

C. Resultado após reposicionar e arrastar pela terceira vez
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Exercício número 5

PROPOSTA DE TRABALHO

Seguindo os passos acima referidos, executa as mesmas operações.
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Sobre cores /amostras

Amostras são cores, tons, gradientes e padrões nomeados. As amostras associadas 

a um documento aparecem no painel Amostras. Essas amostras podem aparecer 

individualmente ou em grupos.

Pode abrir bibliotecas de amostras a partir de outros documentos do Illustrator e vários 

sistemas de cores. As bibliotecas de cores aparecem em painéis à parte e não são salvas 

com o documento.

O painel Amostras e os painéis de bibliotecas de amostras podem conter os seguintes 

tipos de amostras:

Cores de processo

Uma cor de processo é impressa com o uso de uma combinação das quatro tintas de 

processo padrão: ciano, magenta, amarelo e preto. Por padrão, o Illustrator define novas 

amostras como cores de processo. 

Cores de processo globais

Uma cor global é automaticamente atualizada no seu trabalho artístico conforme a 

edita. Embora todas as cores especiais sejam globais, as cores de processo podem ser 

globais ou locais. É possível identificar amostras de cores globais pelo ícone de cor global 

(quando o painel está na exibição em lista) ou por um triângulo no canto inferior (quando 

o painel está na exibição em miniatura).

Cores especiais

Uma cor especial é um tinta pré-misturada que é utilizada no lugar de tintas de processo 

CMYK ou em acréscimo a essas tintas. É possível identificar amostras de cores especiais 

pelo ícone de cor especial (quando o painel está na exibição em lista) ou por um ponto 

no canto inferior (quando o painel está na exibição em miniatura). 
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Gradientes

Um gradiente é uma mistura gradual entre duas ou mais cores ou tons da mesma cor ou 

de cores diferentes. Cores de gradiente podem ser atribuídas como cores de processo 

CMYK, cores RGB ou uma cor especial. A transparência aplicada a um limite de gradiente 

é preservada quando o gradiente é salvo como amostra de gradiente. Os valores de 

proporção e ângulo de gradientes elípticos (criados com o ajuste da proporção ou do 

ângulo de um gradiente radial) não são salvos.

Padrões

Padrões são caminhos repetitivos (lado a lado), caminhos compostos, texto com 

preenchimentos sólidos ou nenhum preenchimento. 

Nenhum

A amostra ‘Nenhum(a)’ remove o traçado ou o preenchimento de um objeto. Não é 

possível editar nem remover essa amostra.

Registo

A amostra de registo é uma amostra integrada que faz com que os objetos preenchidos 

ou tracejados como ela sejam impressos em todas as separações em uma impressora 

PostScript. Por exemplo, marcas de registo usam a cor de Registo, para que as chapas de 

impressão possam ser alinhadas com precisão em um prelo. Não é possível remover essa 

amostra.

Nota: Se usar a cor de Registo para digitação e, em seguida, separar o arquivo e imprimi-

lo, a digitação talvez não seja registada corretamente, e a tinta preta pode ter uma 

aparência turva. Para evitar isso, use tinta preta para digitação.
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Grupos de cores

Grupos de cores podem conter cores de processo, cores especiais e cores globais de 

processo. Eles não podem conter amostras de padrões, gradientes, registos ou do tipo 

Nenhum. Os grupos de cores são criados com base em harmonias, com o uso do painel 

Guia de cores ou da caixa de diálogo Editar cores/Recolorir arte. Para colocar amostras 

existentes em um grupo de cores, selecione essas amostras e clique no ícone Novo 

grupo de cores , no painel Amostras. É possível identificar um grupo de cores pelo ícone 

e pasta.

Também pode criar tons no painel Amostras. Um tom é uma cor de processo global ou 

uma cor especial com intensidade modificada. Tons da mesma cor são vinculados de 

tal forma que, se você editar a cor de uma amostra de tom, todas as amostras de tons 

associadas (e os objetos com elas pintados) mudarão de cor, embora os valores de tom 

permaneçam inalterados. Tons são identificados por uma porcentagem (quando o painel 

Amostras está na exibição em lista).
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Visão geral do painel Amostras

Use o painel Amostras (Janela > Amostras) para controlar todas as cores, gradientes e 

padrões do documento. É possível nomear e armazenar qualquer um desses itens para 

acesso instantâneo. Quando o preenchimento ou o traçado de um objeto selecionado 

contém uma cor, um gradiente, um padrão ou um tom aplicado a partir do painel 

Amostras, a amostra aplicada fica realçada nesse painel.

Painel Amostras na exibição em Lista pequena

A. Cor especial

B. Cor global

C.  Preenchimento ou traçado de Nenhum

D. Amostra de registros (impressa em todas as chapas)

E. Símbolo CMYK (quando o documento está aberto no modo CMYK)

F. Símbolo RGB (quando o documento está aberto no modo RGB)

G. Botão do menu Biblioteca de amostras

H.  Botão do menu Mostrar tipos de amostra

I. Botão Opções de amostra

J. Botão Novo grupo de cores

K. Botão Nova amostra
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Apresentação

Neste módulo pretende-se criar o espaço para o desenvolvimento das aprendizagens 

sobre edição de imagem, iniciadas no módulo de Edição de Imagem I. Pretende-se 

aprofundar os conhecimentos na manipulação de imagens digitais sob a forma de uma 

matriz de pixels.

O docente deverá evidenciar a relação de complementaridade que esta aplicação 

apresenta com a captação de imagens digitais por intermédio de máquinas fotográficas 

digitais ou pela digitalização através de uma mesa digitalizadora.

Objetivos da aprendizagem

Produzir formatos digitais de imagem;

Utilizar camadas (layers);

Editar e corrigir a cor de uma imagem;

Construir e utilizar máscaras;

Trabalhar com vetores;

Recortar silhuetas.

Âmbito dos conteúdos

Camadas;

A opacidade num layer; aplicação de gradientes (dégradés);

Adição de efeitos num layer;

Exercícios de aplicação;

Ilustração a partir de um lineart;

Máscaras e canais;

Gravação da seleção como máscara;

Edição da máscara;

Aplicação de efeito;

Edição de cor;

Curvas e níveis;
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Brancos e negros: Constituição;

Recorte de silhuetas;

Desenho de paths;

Adição e remoção de pontos de ancoragem;

Ajuste da curva de um path;

Propriedades e gravação do path;

Localização do path em relação à figura;

Retoque e pintura;

Criação de dégradés;

Utilização de texturas na pintura/preenchimento de figuras.
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Efeito de vetorização real através do 
Photoshop

01. Para criar este vetor com uma foto será necessário um bom domínio do Photoshop 

e da ferramenta Pen Tool. Para ter um resultado detalhado serão necessárias algumas 

horas ou até dias de trabalho, por isso algumas vezes vale mais a pena realizar este 

tipo de trabalho em softwares que trabalham com vetores. No fim o resultado pode ser 

idêntico, porém com o Photoshop terá um bitmap que, ao contrário do vetor, não irá 

permitir um redimensionamento sem perda de qualidade.

Pressione Ctrl+O e abra a foto escolhida para ser trabalhada, para este tutorial.

02. Pressione Ctrl+Shift+Alt+N para criar uma nova layer, defina sua cor de Foreground 

com a cor #D9BA8D, pressione a letra P do teclado para selecionar a Pen Tool  para criar 

a pele vá clicando e contornando todas as áreas de pele que estejam visíveis, na imagem 

abaixo começamos a contornar o braço.
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03. Na parte dos dedos não se preocupe em fazer divisões exatas ou como na imagem 

que estamos usando os dedos se confundem e somem nos cabelos por isso não se 

preocupe em fazer esta parte com muita exatidão, pois eles serão cobertos pelos cabelos 

mais a frente.

04. Ao terminar de contornar todas as áreas de pele da imagem, clique com o botão 

direito dentro do contorno e escolha a opção Fill Path, note que em algumas áreas como 

as áreas próximas a roupa e os cabelos não estão bem desenhados, mas não se preocupe, 

pois mais à frente isto irá desaparecer.
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05. Pressione Ctrl+Shift+Alt+N para criar uma nova layer, desta vez faremos o contorno do 

rosto, não se preocupe com olhos, boca e nariz neste momento, faça apenas o contorno 

como foi feito anteriormente com o corpo e preencha a seleção com a cor #E2C59B caso 

esteja a usar a imagem do tutorial.

06. Pressione Ctrl+Shift+Alt+N para criar uma nova layer, desta vez faremos o contorno 

do vestido, escolha a cor desejada mas escolha uma cor escura (com exceção da cor 

preta), pois mais adiante usaremos cores mais claras para criar os detalhes do vestido 

e o preto para criar as áreas de sombra. Neste tutorial usamos a cor #196339, proceda 

como nos passos anteriores. 
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07. Pressione Ctrl+Shift+Alt+N para criar uma nova layer, desta vez faremos a parte dos 

cabelos, para o cabelo da fotografia usada neste tutorial foi usada a cor #784234, que é 

a cor de base para cabelos pretos, caso seja feito num cabelo loiro não comece com o 

amarelo e sim com um tom marrom, pois o que estamos a fazer agora é apenas a base, 

repita o mesmo procedimento realizado nos passos anteriores, a sua imagem deverá 

ficar como a imagem abaixo.

08. Com a base pronta agora é a hora de adicionar as 

sombras, quanto mais sombra mais realista a imagem 

irá ficar, quanto menos sombra menos realista e com 

mais cara de Cartoon a sua imagem irá ficar, comece 

por duplicar a fotografia original pressionando Ctrl+J, 

faça isso 4 vezes, 1 para o corpo, 1 para o vestido, 1 

para o rosto e 1 para o cabelo, e deixe as layers como 

na foto abaixo.
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09. Agora pressione Ctrl+Alt+G (Ctrl+G na versão CS 

do Photoshop), ou em Layer> Create Clipping Mask, 

aplique nas layers que contenham a fotografia usada, 

a sua paleta de layers deve ficar como a da imagem 

abaixo. 

10. Clique com a tecla Ctrl sobre as miniaturas das layers que contêm os contornos feitos 

para ativar a seleção, em seguida vá a Select> Inverse ou pressione Ctrl+Shift+I, clique na 

layer da fotografia que está acima desta layer e pressione Delete, faça isto com todos os 

contornos feitos, com isto estamos a apagar da fotografia usada as partes que não são 

necessárias.

11. Agora clique na layer que contém a imagem do corpo e depois vá a Image> 

Adjustments> Desaturate ou pressione Ctrl+Shift+U, isto irá deixar a fotografia a preto 

e branco, em seguida vá a Image> Adjustments> Posterize, defina um valor entre 8 e 

9 e pressione Ok, faça isto em todas as layers de fotografia que estamos a trabalhar 

(corpo, rosto, cabelo e vestido), porém cada parte do corpo possui um valor diferente no 

filtro Posterize, isto vai muito da fotografia escolhida e de quanto de detalhes queremos 

trabalhar na foto.

12. Clique na foto do corpo e pressione Ctrl+Shift+Alt+N para criar uma nova layer e 

pressione Ctrl+Alt+G (Ctrl+G no Photoshop CS) ou vá a Layer> Create Clipping Mask, 

pressione a letra D do teclado para definir a sua cor de Foreground como preta (#000000), 
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pressione a letra P do teclado para selecionar a Pen Tool e crie seleções nas áreas escuras 

(sombras) do corpo primeiro, pegando a cor preta com o tom de cinza mais próximo, a 

cor de base que foi feita antes aqui está representada pelo cinza claro, por isso todas as 

outras tonalidades serão trabalhadas mais adiante.

13. Retire a visualização da layer que acabou de ser trabalhada e pressione 

Ctrl+Shift+Alt+N para criar mais uma layer, aplique outro Clipping Mask pressionando 

Ctrl+Alt+G (Ctrl+G no Photoshop CS) ou indo a Layer> Create Clipping Mask, pressione 

a letra P para selecionar a Pen Tool e desta vez selecione a cor preta junto com mais 2 

tonalidades de cinza, repita o processo de crição de layer e seleção em redor da cor até 

ter selecionado todas as cores, sempre que for criar uma nova layer retire a visibilidade 

da layer anterior, no tutorial foram criadas 4 layers de seleções em preto, porém isso 

pode variar dependendo da imagem ou nível de detalhe no filtro Posterize. Agora defina 

a sua cor de Foreground em branco (#ffffff), pressione Ctrl+Shift+Alt+N para criar uma 

nova layer e depois pressione Ctrl+Alt+G (Ctrl+G no Photoshop CS) ou vá em Layer> 

Create Clipping Mask, pressione a letra P do teclado para selecionar a Pen Tool e crie 

uma seleção nas áreas claras da imagem, no tutorial foram feitas duas layers pegando 

do tom mais claro para um escuro e depois do claro para dois tons mais escuros, depois 

de feito isso ative a visualização de todas as layers (com exceção da layer da fotografia do 

corpo) e mude o modo de blend das layers que acabámos de criar para Soft Light.
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A sua imagem deve estar parecida com a imagem abaixo.
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14. Diminua a opacidade das layers que acabamos de trabalhar (seleções de preto 

e branco do corpo) para 30%, clique com a tecla Ctrl pressionada na miniatura da 

primeira layer de sombra (seleção em preto) para ativar a seleção em redor, pressione 

Ctrl+Shift+Alt+N para criar uma nova layer e vá a Select> Modify> Contract e defina 

um valor de 3 pixels, clique em Ok, 

pressione a letra G do teclado para 

selecionar a Paint Bucket Tool e 

preencha a seleção com a cor preta, 

mude o modo de blend da layer para 

Soft Light e defina o valor de 30% 

para Opacity. Faça isto para cada 

layer em preto e branco (do corpo) 

que acabámos de trabalhar, sua 

imagem irá ficar assim.

15. Agora iremos trabalhar o vestido, o processo é o mesmo, pressionar Ctrl+Shift+Alt+N 

para criar uma nova layer, Ctrl+Alt+G (Ctrl+G no Photoshop CS) ou vá a Layer> Create 

Clipping Mask, pressionar a letra P 

do teclado para selecionar a Pen Tool 

e ir criando as seleções sempre em 

novas layers e retirando a visibilidade 

da layer anterior, ao final mudar o 

modo de blend da layer para Soft 

Light com opacidade de 30%.
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16. O próximo passo é trabalhar o rosto, como o mesmo processo que fizemos 

anteriormente, por enquanto trabalhe apenas o rosto sem mexer nos olhos e lábios. 

17. Agora trabalharemos o cabelo, que é a parte mais complicada e demorada, para 

começar faça todo o processo que foi aplicado noutras partes do corpo e descrito 

anteriormente. 
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18. Adicione mais detalhes na cor branca e na cor preta para deixar os cabelos mais 

realistas, criando inclusivé a direção do penteado para dar mais realismo, como pode ser 

observado na imagem abaixo.

19. O último passo para o cabelo é criar alguns fios que saem para dar mais realismo, 

pressione Ctrl+Shift+Alt+N para criar uma nova layer, pressione a letra G do teclado para 

selecionar a Paint Bucket Tool e pinte esta nova layer com a cor cinza clara, coloque esta 

layer abaixo das outras para criar um fundo cinza. Este fundo servirá apenas para criar 

um contraste e ajudar na visualização dos traços, novamente crie uma nova layer acima 

da layer do cabelo pressionando Ctrl+Shift+Alt+N, não crie um Clipping Mask para esta 

layer, defina sua cor de Foreground com a cor #5E2E24, pressione a letra P do teclado 

para selecionar a Pen Tool e desenhe pequenos fios saindo do cabelo como mostrados 

nas fotografias abaixo. 
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20. Abaixo pode ver as áreas que foram criadas, selecionadas e depois como ficou.

21. O próximo passo será criar os elementos do rosto, começando pelas sobrancelhas, 

pressione Ctrl+Shift+Alt+N para criar uma nova layer acima da layer do rosto, defina a  

sua cor de Foreground para #5E2E24, pressione a letra P do teclado para selecionar a 

Pen Tool e crie a seleção em redor da sobrancelha, depois clique com o botão direito do 

rato e escolha a opççao Fill Path e pressione Ok.

 

ManualArtesGraficasEdicaoEletronicaMod5a8.indd   88 14-03-2014   17:45:35



Manual do Aluno

CURSO TÉCNICO DE  ARTES GRÁFICAS | 89

22. Pressione Ctrl+Shift+alt+N para criar uma nova layer, pressione a letra P do teclado 

para selecionar a Pen Tool e crie uma seleção em redor da parte branca do olho direito, 

preencha com a cor #A18D97, nunca com a cor branca pura.

23. Pressione Ctrl+Shift+Alt+N para criar mais uma layer e retire a visualização da outra 

layer do olho, pressione a letra P do teclado para selecionar a Pen Tool e crie uma 

seleção em redor da íris, preencha a seleção com a cor #343C31. Pressione novamente 

Ctrl+Shift+Alt+N para criar uma nova layer e retire a visualização da layer que estavamos 

a trabalhar (a layer da íris), pressione a letra P do teclado para selecionar a Pen Tool e 

desenhe em redor da pupila, preencha a seleção com a cor preta, ative a visualização das 

2 outras layers do olho para ver como está ficando.
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24. Pressione Ctrl+Shift+Alt+N para criar uma nova layer onde faremos os cílios, crie a 

seleção e preencha com a cor preta, logo após pressione novamente Ctrl+Shift+Alt+N 

para criar uma nova layer e posicione esta layer abaixo das outras layers do olho, 

pressione a letra P do teclado para selecionar a Pen Tool e desenhe as áreas de sombra 

do olho. No final preencha a seleção com a cor preta, mude o modo de blend da layer 

para Soft Light, assim teremos 3 layers com sombras e áreas escuras e 2 de áreas claras, 

deixe as layers de áreas claras com modo de blend Soft Light e opacidade em 100%, as 

áreas de sombra (pretas) ficam com modo de blend em Soft Light e opacidade em 80%.

25. Clique na layer que contém a parte branca do olho e pressione Ctrl+Shift+Alt+N 

para criar uma nova layer e depois pressione Ctrl+Alt+G (Ctrl+G no Photoshop CS) ou 

vá a Layer> Create Clipping Mask, defina a sua cor de Foreground em branco (#ffffff), 

pressione a letra P do teclado para selecionar a Pen Tool e desenhe duas áreas como 

as mostradas na foto abaixo, preencha com a cor branca e defina o valor de 70% para a 

opacidade da layer.

26. Pressione Ctrl+Shift+Alt+N para criar outra layer e depois pressione Ctrl+Alt+G (Ctrl+G 

no Photoshop CS) ou vá a Layer> Create Clipping Mask, pressione a letra P do teclado 

para selecionar a Pen Tool e desenhe duas áreas como as da foto abaixo, preencha as 

seleções com a cor preta e mude o modo de blend da layer para Soft Light.
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27. Agora clique na layer da íris e depois pressione Ctrl+Shift+Alt+N para criar uma nova 

layer, pressione Ctrl+Alt+G (Ctrl+G no Photoshop CS) ou vá a Layer> Create Clipping 

Mask, pressione a letra B do teclado para selecionara Brush Tool, defina um tamanho de 

3 pixels, e desenhe um contorno ao redor da área verde usando a cor preta, pressione 

Ctrl+Shift+Alt+N para criar uma nova layer e pressione Ctrl+Alt+G (Ctrl+G no Photoshop 

CS) ou vá a Layer> Create Clipping Mask, pressione a letra B do teclado para selecionar a 

Brush Tool novamente e com a cor branca desenhe alguns pontos em volta da área verde 

do olho, mude o modo de blend da layer para Soft Light com 70% de opacidade.

28. Pressione Ctrl+Shift+Alt+N para criar uma nova layer acima da layer da pupila, 

pressione a letra B do teclado para selecionar a Brush Tool com tamanho de 1 pixel na 

cor branca, desenhe um ponto como o da fotografia abaixo.

29. Neste momento a sua imagem deve estar parecida com a imagem abaixo.
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30. Para o olho esquerdo basta duplicarmos o olho direito, para isso criamos um layer 

set (uma pequena pasta contendo todas as layers do olho), para criar a layer set, clique 

no ícone de uma pasta que fica no rodapé da paleta de layers, isto irá criar uma pequena 

pasta na sua paleta de layers, clique e arraste todas as layers do olho para dentro desta 

pasta. Feito isto, clique com o botão direito do rato sobre a pasta e escolha a opção 

Duplicate Layer Set, clique na pasta que foi criada e vá a Edit> Transform> Flip Horizontal, 

pressione a letra V do teclado para selecionar a Move Tool e mova o olho para a posição 

correta, pressione Ctrl+T para acertar o ângulo correto do olho em relação ao rosto.

31. Agora faremos os lábios, escolha uma cor qualquer, para este tutorial usamos um 

vermelho escuro (#A7545B), pressione Ctrl+Shift+Alt+N para criar uma nova layer e 

depois pressione a letra P do teclado para selecionar a Pen Tool, crie o contorno dos 

lábios e preencha na cor escolhida, novamente pressione Ctrl+Shift+Alt+N para criar 

outra layer, pressione Ctrl+Alt+G (Ctrl+G no Photoshop CS) ou vá a Layer> Create Clipping 

Mask e crie uma seleção em redor das áreas escuras dos lábios.
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32. Crie também a divisão dos lábios, no final mude o modo de blend da layer para Soft 

Light com opacidade em 55%.

33. Crie mais algumas camadas repetindo os passos feitos em outras partes do corpo até 

achar que conseguiu um bom resultado.

34. Para o nariz, pressione Ctrl+Shift+Alt+N para criar uma nova layer e pressione a 

letra P do teclado para selecionar a Pen Tool, crie uma seleção em redor das narinas e 

definições do nariz e preencha com a cor preta, mude o modo de blend da layer para 

Soft Light.
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35. Abaixo a imagem no final.

36. Com algumas variações de Background.
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Exercício número 1

PROPOSTA DE TRABALHO

Através de uma imagem semelhante reproduzir todas as fases acima assinaladas para 

obter o mesmo efeito.

Exercício número 2

PROPOSTA DE TRABALHO

Depois de ter praticado com algumas imagens todo o processo, desta vez terá de 

aplicar de novo todas as fases, mas sem recorrer a ajuda do manual.
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Gradient Tool ou Ferramenta Degradê.

Gradient Tool ou Ferramenta Degradê, é uma ferramenta secundária da Paint Bucket 

Tool, ou seja, para aceder a esta ferramenta deve clicar sobre a Paint Bucket Tool e manter 

o botão pressionado até ver o ícone da Gradient Tool, por isso o atalho de teclado é o 

mesmo da Paint Bucket Tool. Porém a ferramenta tem uma função bem diferente, ela 

cria transições entre duas ou mais cores de forma suave com a possibilidade de aplicação 

de 5 efeitos distintos entre outras opções, que são apresentadas na barra de opções da 

ferramenta como veremos a seguir.

Gradient Tool - Ferramenta Degradê

Tecla de atalho: Letra G do teclado

Barra de Opções da Gradient Tool

Ao aceder a Gradient Tool pela paleta de ferramentas ou atalho de teclado vemos a 

barra de opções da ferramenta no alto da tela com as seguintes opções.

Degradês

Na barra de opções a primeira caixa da esquerda para a direita apresenta a opção de 

Degradê que apresenta as cores que você tem como Foreground e Background com o 

efeito de Degradê, ao lado vemos uma pequena seta, que ao ser clicada revela outras 

combinações de Degradê que podem ser escolhidas e customizadas.

Customizando um Degradê

Para criar um Degradê customizado basta clicar duas vezes sobre a caixa de Degradê (a 

da fotografia anterior) e será aberta a caixa do Editor de Degrade.

1. Nesta parte tem todos os Degradês já criados e aqueles que criar e salvar também 

ficarão nesta caixa para posterior uso.
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2. Ao clicar nesta seta um menu abrirá mostrando as várias opções de customização para 

a caixa de Degradês.

3. Nesta área pode salvar e dar um nome a um novo Degradê que cria nas opções que 

estão abaixo, e que futuramente estará na caixa de Degradês logo acima.

4. Nesta caixa definimos o tipo de Degradê, existem duas opções, Solid ou Noise, cada 

uma delas apresenta opções de customização diferentes.

5. Clique sobre esta seta para definir a Opacidade da cor neste ponto, note que ao clicar 

nesta seta a caixa Opacity(9) logo abaixo fica ativa, dando a possibilidade de edição da 

opacidade da cor.

6. Clique sobre esta seta para definir a cor do Degradê nesta parte, isto pode ser feito de 

duas maneiras, clicando duas vezes sobre esta seta a caixa Color Picker irá abrir dando 

a possibilidade da escolha de cor, e usando a opção Color(10) logo abaixo que ao ser 

clicada oferece as opções Foreground, Background e User Color.

7 e 8. Contém as mesmas funções de 5 e 6 controlando a cor e opacidade da direita.

Para criar mais pontos de cor basta clicar acima da barra de Degradê onde temos as setas 

de control e para que apareçam mais pontos e assim criar Degradês diferenciados.

A opção Smooth controla a suavização da transição de cores.

Ao se escolher a opção Noise a caixa seguinte abrir-se-á, ela apresenta opções 

diferenciadas em relação a opção Solid.

Roughness - Defina a suavização entre as cores.

Color Model - Permite a edição de cores em três modos diferentes, RGB, HSB e LAB.

Restrict Colors - Ative esta opção caso queira retirar cores fora da gama de impressão.

Add Transparency - Ative esta opção para ter transparência no seu Degradê.

Randomize - Ao ser clicado irá randomizar o Degradê, oferecendo outras opções dentro 

do modo de cor escolhido.
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Opções de Degradê

Para criar um Degradê é simples, com a Gradient Tool selecionada basta clicar num ponto 

do seu documento arrastar e soltar noutro ponto, temos 5 opções de Degradê como as 

mostradas abaixo.

1 - Linear Gradient

2 - Radial Gradient

3 - Angle Gradient

4 - Reflected Gradient

5 - Diamond Gradient

Abaixo temos todos os Degradês aplicados.

Mode e Opacity

Em mode é possível definir o modo de blend para o Degradê, ao clicarmos no menu 

Mode uma série de opções são mostradas, em Transparency podemos definir o valor da 

transparência que o Degradê terá após ser aplicado.

Reverse, Dither e Transparency

A opção Reverse muda a direção do Degradê de forma inversa ao ser clicado, Dither 

suaviza a transição de cores, por mais imperceptível que seja é sempre aconselhável 

que esta opção esteja sempre ativada e transparency define a transparência através das 

cores usadas no Degradê. Quando usadas no modo de Edição de Degradê, ela pode ser 

ativada ou desativada pela barra de opções.

Exercício número 3

PROPOSTA DE TRABALHO

Elabora vários degrades conforme está acima mencionado.

ManualArtesGraficasEdicaoEletronicaMod5a8.indd   98 14-03-2014   17:45:40



Manual do Aluno

CURSO TÉCNICO DE  ARTES GRÁFICAS | 99

Paleta Layers

O controle das camadas é feito pela Palheta “Camadas” ou “Layers”. Se não vê essa 

palheta vá a Window > Layers e ela aparecerá.

Como pode ver na imagem acima, as camadas podem ser sobrepostas. As de baixo ficam 

atrás das de cima. Assim pode editar o conteúdo de cada camada separadamente e 

movê-las independentemente também.

No exemplo acima temos uma camada totalmente branca (pode ver pela miniatura ao 

lado do nome da camada como ela é, neste caso, é toda branca). Em cima dela temos 

uma camada totalmente preta. Como ela está acima da camada branca é ela que aparece.

Depois vemos uma camada vazia. Tudo que é “vazio” no Photoshop é representado por 

esse quadriculado cinza.

Depois temos uma camada com um quadrado vermelho. Acima dela temos um quadrado 

amarelo. Como consequência o amarelo fica na frente do vermelho, quando vemos o 

resultado final.

Visualização

Todas elas têm um “olho” ao lado esquerdo. Ele serve para “esconder” a camada 

provisoriamente. Se existe o olhinho ali quer dizer que está a ver a camada no resultado 

final. Se clica nele o olhinho desaparece. Isso significa que a camada ainda existe, mas 

não a está a ver no resultado final.
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Veja na imagem acima: o quadrado amarelo está sem o olhinho (é só clicar em cima e 

ele desaparece). Por isso não conseguimos ver esse quadrado na imagem. Se quisermos 

vê-lo novamente é só clicar no quadradinho vazio onde estava o olho.

Nome da camada

O nome da camada é muito importante para nos organizarmos entre várias camadas. 

Conforme criamos novas camadas, o Photoshop nomeia-as automaticamente como 

“Layer 1″, “Layer 2″, “Layer 3″ e assim por diante.

Como isso não diz nada sobre as camadas, o melhor a fazer é renomear cada uma com 

algo que diga o que elas são. Para fazer isso clique duas vezes exatamente em cima do 

nome atual. Agora é só substituir e pressionar Enter.
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Formatos de camadas

Fora o olhinho e o nome, as camadas têm representações um pouco diferentes de acordo 

com o seu tipo.

Camadas bitmap: não se preocupe em saber tecnicamente o que é “bitmap” ainda. Uma 

camada bitmap é uma camada que contém uma imagem qualquer (como os quadrados 

coloridos dos exemplos acima, ou uma foto!).

Camada de texto: como o nome diz, uma camada de texto contém um texto! Ela é 

representada por um quadrado branco com um “T” dentro. Esse texto pode ser editado 

a qualquer momento.
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Camada vetorial: é o resultado da criação de uma “forma”. Sempre que cria formas 

(shapes) com ferramentas, como a Pen Tool ou Shape, como o coração acima, o resultado 

vai ser uma camada vetorial. Não se preocupe em saber tecnicamente o que é um vetor 

ainda. Essa camada é representada por uma cor (a cor da forma) e um retângulo cinza 

com a forma dentro em branco (como podem ver ali em cima o retângulo cinza tem um 

coração dentro).

Outras camadas: existem também camadas de ajuste.

Começando a trabalhar com camadas

Ao abrir uma foto (Ctrl+O) vai ver uma só camada chamada “Background”. Essa camada 

tem um cadeado do lado, o que significa que ela não pode ser movida. E nem queremos 

isso! Vamos deixar a camada Background intacta.

Para criar uma nova camada vamos utilizar o atalho 

Ctrl+Shift+Alt+N. Se não quiser decorar agora, pode clicar no 

ícone de New Layer, que fica lá em baixo da Palheta Layers.
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Ao clicar, uma nova camada transparente será criada. Como ela é transparente (não tem 

nada) não verá diferença nenhuma na imagem final!

Agora vamos selecionar essa camada (é só clicar em cima dela uma vez). Assim podemos 

começar a editá-la. Selecionando a ferramenta Brush (B) vamos pintar algo nessa camada.

Agora, por mais que pareça que estragamos totalmente a fotografia, não há com o 

que se preocupar. A mancha vermelha está numa camada separada, então a qualquer 

momento podemos movê-la, editá-la e até apagá-la.
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Vamos criar outra camada com outra mancha.

Se quisermos mover as camadas, é só utilizar a ferramenta Mover (V). Se quisermos 

mudar a posição da camada, é só clicar nela e manter o botão do rato pressionado. Aí 

movemo-la para baixo ou para cima na hierarquia de camadas.
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Agora a mancha amarela está debaixo da outra (dá para ver o resultado na imagem!).

Se quisermos retirar essas camadas é só estar com a ferramenta Mover (V) selecionada e 

utilizar a tecla “Delete” no teclado. Se não quiser utilizar o teclado, clique no ícone “Lixo” 

que fica lá em baixo da palheta Layers.

Terminou, fez várias edições, mas a imagem inicial ainda está intacta!
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Exercício número 4

PROPOSTA DE TRABALHO

Escolhe uma imagem e reproduz todas as fases acima assinaladas para obter o mesmo 

resultado.

Exercício número 5

PROPOSTA DE TRABALHO

Escolhe uma imagem e reproduz todas as fases acima assinaladas para obter o mesmo 

resultado desta vez sem o uso do manual como guia.
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Recortar uma silhueta

Na hora de retocar uma imagem ou de trabalhar com arquivos gráficos para fazer 

composições, uma das tarefas mais habituais é realizar seleções de áreas, para recortar 

e colar na composição ou retoque fotográfico. Neste workshop para novatos em 

Photoshop, vamos explicar o modo de trabalho da ferramenta de seleção poligonal, que 

seria a mais fácil para começar a fazer seleções complexas de áreas irregulares.

O mais importante de Photoshop, pelo menos para começar, é dominar as camadas e 

seleções. Este seria o primeiro tutorial para conhecer as seleções complexas, para realizar 

recortes de áreas da imagem em que se poderão utilizar composições. Nos próximos 

artigos veremos outras ferramentas para fazer o trabalho com maior detalhe e precisão, 

utilizando ferramentas mais complexas.

Ferramentas de laço poligonal

Não obstante, comecemos por ver onde está a ferramenta de laço poligonal. Encontra-

se junto com a ferramenta de laço e com a de laço magnético. Se tivermos qualquer 

destas ferramentas selecionadas, para aceder ao laço poligonal simplesmente temos 

que clicar com o rato continuamente durante uns segundos, para que nos mostre e 

possamos selecioná-la.

Uma vez selecionada podemos experimentar com ela fazendo umas provas. Clicamos 

em qualquer parte da imagem e com isso começaremos a construção da seleção. Logo 

podemos ir clicando em diversas áreas da imagem para ir definindo o perímetro da 

seleção.
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Uma vez definido o perímetro da seleção, devemos fechá-la para terminar a sua definição 

e poder operar com ela. Quando se fecha a seleção aparece um pequeno símbolo ao 

lado do cursor do rato com um círculo. Isto quer dizer que, se clicarmos a seleção, ficará 

fechada e com isso perfeitamente definida.

Outra opção para fechar uma seleção poligonal é clicar duas vezes em qualquer parte da 

tela. Com isso, fechar-se-á a seleção unindo o primeiro ponto com o lugar onde se fez o 

clique duplo.

Seleção de uma silhueta com o laço poligonal

A seleção tem que começar por um ponto e acabar no mesmo ponto, por isso podemos 

escolher qualquer ponto que nos interesse. Então, vamos fazendo ponto a ponto, o 

percorrido da silhueta. Alguns conselhos para fazer uma boa seleção seriam:

Ter em conta que quantos mais pontos colocar, melhor definida estará a seleção.

Não clique muito rápido no botão do rato entre ponto e ponto, pois se dois cliques muito 

juntos forem confundidos por um clique duplo fechar-se-á a seleção.

Faça bastante zoom para engrandecer a visualização da imagem, para poder fazer a 

seleção sobre uma área maior onde tiver melhores possibilidades de marcar pontos nos 

lugares corretos.

Se for reduzir a imagem de dimensões, convém fazer a seleção da silhueta antes de 

reduzi-la. Assim, mesmo que tenha algumas imperfeições, dissimular-se-ão ao reduzir a 

imagem. Se o fizer com a imagem reduzida diretamente ver-se-ão os defeitos da seleção.

Se se equivocar, por deixar de selecionar uma área que lhe interessava ou por selecionar 

uma área que não desejava, não se preocupe. O melhor é que continue até terminar a 
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seleção e logo tire ou adicione mais área. Para tirar uma seleção a outra tem que apertar 

a tecla alternativa (Alt) quando começar a fazer a seleção que quer tirar a qual já tem 

realizada (você verá que aparece um sinal de menos “-” ao lado do cursor do rato). 

Para adicionar uma seleção a outra utilize a tecla maiúsculas (também chamada Shift, 

que tem a seta para cima) no momento que começar a fazer a nova seleção que quer 

adicionar (verá que aparece um sinal “+” ao lado do cursor do rato).

Quase sempre é bom utilizar um suavizado na seleção. E nos casos em que a silhueta 

selecionada for muito grande ou que iremos colá-la em cima de outra imagem, seria 

bom experimentar com diversas configurações de esfumado.

Seja paciente, porque é uma operação delicada e um clique em falso pode prejudicar 

muito a seleção realizada durante vários minutos. 

Nos próximos artigos explicaremos como fazer a seleção com a ferramenta pluma, que 

nos permitirá resultados muito melhores, apesar do funcionamento se tornar mais 

complexo.
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Seleções com a varinha mágica

A ferramenta varinha mágica de Photoshop serve, como dizia, para fazer seleções. As 

seleções que se podem fazer com a varinha são de qualquer tipo, quadradas, redondas, 

poligonais ou de formas irregulares, portanto é bastante versátil. O uso é o seguinte:

Selecionamos a ferramenta varinha mágica, que tem esta forma:

Logo, podemos clicar em qualquer parte de uma imagem com a varinha e então 

obteremos uma seleção dentro da imagem. Para estabelecer os limites da seleção, o 

Photoshop avaliará as cores que há a lado do pixel marcado com o clique e se forem o 

mesmo, ou similares, a seleção também abarcará esses pontos. Desta maneira, continua 

mostrando cores da imagem e adicionando à seleção se forem parecidos. O resultado é 

que a seleção vai crescendo pelas partes da imagem que tiverem uma cor homogénea ou 

similar. Sendo assim, os limites da seleção criada serão marcados pela forma da própria 

imagem e as cores que tiver.

A varinha serve, por exemplo, para selecionar 

silhuetas numa fotografia. Se tivermos uma foto 

com um céu homogéneo e utilizarmos a varinha 

sobre o céu, selecionar-se-á toda a área azul. 

Podemos ver na seguinte imagem uma seleção 

feita com a varinha mágica do céu desta foto 

tirada em Valência. 

Como veremos na imagem, selecionou-se a 

maioria do céu, ajustando os limites da seleção 

à das figuras captadas na foto. Como veremos, 

ManualArtesGraficasEdicaoEletronicaMod5a8.indd   110 14-03-2014   17:45:47



Manual do Aluno

CURSO TÉCNICO DE  ARTES GRÁFICAS | 111

nem todo o céu foi selecionado, porque há partes do mesmo que não são muito parecidas 

com a cor azul sobre a qual clicámos inicialmente e, portanto, não se mostraram como 

cores parecidas e não se carregaram na seleção.

Opções da varinha mágica de Photoshop

Com as opções da ferramenta varinha mágica, podemos modificar o seu comportamento, 

para, por exemplo, dizer quão estrito ou tolerante deve ser a amostragem da imagem 

para definir as bordas da seleção. As opções de qualquer ferramenta de Photoshop 

podem ser vistas geralmente na parte de cima da janela do programa e se não aparecem, 

podemos forçar que se mostrem com o menu Janela - Opções.

A mais importante das opções de varinha é a Tolerância. Que permite especificar com 

um número tão tolerante ou estrito a mudanças nas cores como for a seleção. Ao 

menor valor de tolerância, mais estrita será a amostragem de cores. De tal modo que, 

se colocarmos tolerância zero, só se selecionariam as partes contínuas ao ponto onde 

fizemos o clique da imagem que tiver a mesma cor. Se a tolerância for muito alta a 

seleção expandir-se-á, embora as cores variem mais. Se ao fazer a seleção da anterior 

imagem tivéssemos marcado tolerância mais alta, por exemplo 60, teria selecionado 

toda a área da foto que corresponde ao céu.

Portanto, para ajustar as partes da imagem que entrarão dentro da seleção com a 

varinha, devemos ajustar o valor tolerância.

Entre as opções também há outras importantes:

Antialiasing, permite que as bordas da seleção se suavizem, de modo que embora sejam 

curvas, não se produza um pixelado.

Contíguo é para que a seleção só seja de pixels contíguos. É o modo por padrão e como 

explicamos a ferramenta. Porém, se não o marcamos, permite selecionar todos os pixels 

da imagem que tiverem uma cor parecida, embora não estejam contíguas ao lugar onde 

fizemos clique inicialmente.
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Mostrar todas as camadas tem uma utilidade interessante quando trabalhamos com 

distintas camadas em Photoshop. Uma coisa importante: com a varinha mágica, no 

princípio, fazemos seleções sobre a camada em que estivermos trabalhando, sem 

mostrar outras que possam estar abaixo ou acima. Se selecionarmos mostrar todas as 

camadas, faremos com que a varinha se fixe em todas elas como se fosse uma só.
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Apresentação

O fundamento deste módulo prende-se com a criação de espaço para o desenvolvimento 

das aprendizagens na aplicação no módulo de Paginação I. Propõe-se o desenvolvimento 

de projetos que permitam o aprofundar dos conhecimentos na utilização de uma 

aplicação informática de paginação.

O docente deverá evidenciar a relação de complementaridade que esta aplicação 

informática poderá ter com outras e relacionar os conteúdos deste módulo com outros 

de outras disciplinas ou projetos turma.

Objetivos da aprendizagem

Criar e utilizar corretamente páginas mestras;

Identificar as técnicas mais eficazes de criação de diferentes tipos de índices;

Identificar e experimentar as técnicas de maquetização, revisão e correção;

Preparar um trabalho para impressão.

Âmbito dos conteúdos

Criação e utilização de páginas mestras;

Listas e índices;

Saídas e análise de provas;

Revisão e acertos de provas;

Preparação para impressão.
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Conceitos Básicos de documentos e 
Páginas Mestre

O InDesign é um potente software criado pela Adobe, os mesmos criadores do Photoshop, 

Illustrator, Fireworks e várias outras aplicações criativas.

É um dos aplicativos padrão da indústria usados ​​para criar (ou, mais provavelmente 

«juntos») documentos impressos, como revistas e livros. Ele pode ser usado para a 

produção de produtos de impressão a partir do zero, mas é na verdade projetado para 

importar os seus gráficos já criados a partir de outros softwares como Photoshop e 

Illustrator, bem como documentos com várias páginas.

 Ele também pode ser usado para criar uma página de documentos, tais como folhetos e 

cartazes, no entanto, ele não é muito usado para este fim, como o Photoshop e Illustrator 

são capazes disso sem ter que exportar e importar os gráficos.

O InDesign tem um concorrente conhecido, QuarkXPress, que também é uma aplicação 

padrão da indústria.

O que são Páginas mestre?

Páginas mestras são usadas para exibir a mesma informação em cada página em todo o 

documento - pode pensar neles como um modelo para páginas específicas. Por exemplo, 

se queria um logótipo da empresa a ser exibido no rodapé de cada uma de suas páginas, 

pode aplicar uma página mestra para cada um.

Não está restrito a apenas uma página principal, no entanto, pode configurar dois (e mais 

do que isso), permitindo-lhe aplicar mestre páginas diferentes para páginas diferentes, 

acelerar o seu andamento do trabalho, mas permitindo que tenha um pouco de variação, 

ao mesmo tempo. Por exemplo, num layout de revista, um designer de layout pode ter 

uma página principal configurado para uma característica particular que publicar em 

cada edição da sua revista, permitindo-lhes facilmente importar texto e gráficos em 

espaços reservados já criados.

É uma maneira simples e rápida para a produção de design consistente, sem ter que 

mexer muito com dimensões e estágios.
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Páginas Mestre e Guias

Uma guia é uma linha de pixels de largura que aparece no monitor, mas não será 

impresso quando o documento é enviado para a gráfica, e não vai aparecer depois de 

ter exportado o documento para PDF. As guias também podem ser escondidas, se não 

quiser vê-las enquanto elas não são usadas para o que está a fazer atualmente.

Adicionar guias às suas páginas mestras é fácil. Dê um duplo clique no seu “A-Master” 

páginas, que se encontra na secção superior do painel de páginas. As duas páginas 

mestras aparecerão na janela do seu documento.

Existem várias maneiras de adicionar guias. Pode arrastá-las diretamente para fora dos 

seus documentos, ou adicioná-las ao seu documento, precisamente por ir a Layout> 

criar guias. Vamos fazer isso da maneira precisa, então vá a Layout> Criar guias.

Nós vamos criar um guia de rede para as nossas páginas mestre. Verifique se a caixa de 

seleção prévia está marcada - o que irá nos permitir ver onde os nossos guias estão a ser 

colocados. Certifique-se também que as guias de ajuste à caixa margens está marcada - 

o que irá atender as guias de maneira uniforme entre as guias, em vez de a página, que 

é o que nós queremos, já que iremos ter certeza que todo o texto é colocado dentro de 

nossas margens, em vez da nossa página.

Adicione 8 linhas com uma calha de 0 milímetros e duas colunas com uma calha de 3mm 

e clique em OK. 
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Com nossas páginas mestre agora cheias de guias, vai notar que todas as nossas páginas 

têm agora este guia configurar. Pode ver todas as páginas ao mesmo tempo, diminua o 

zoom - pode fazer isso indo para Visualizar> Menos Zoom. 

Páginas Mestre e Texto

Agora que já viu como é simples de usar o recurso de páginas mestre no InDesign, que 

vai passar para a adição de algum texto em páginas dos nossos mestres. Qualquer texto 

(ou imagens) que coloca nas páginas mestras também vai aparecer no mesmo lugar em 

todas as outras páginas que têm a página principal aplicada a eles - é ideal para coisas 

como um rodapés, logótipos e cabeçalhos.
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Dê um duplo clique em voltar para a sua página mestre A-Master. Zoom (Visualizar> 

Ampliar) para as páginas mestras preencher a tela, ou vá a Exibir> Espalhe Ajustar à 

janela para fazer isso automaticamente. Selecione a ferramenta Type e arraste uma 

caixa de seleção no rodapé da sua página principal esquerda, exatamente como faria em 

qualquer outro documento ao usar qualquer outro aplicativo com a mesma ferramenta. 

Preencha a sua caixa de texto com algum texto - eu vou usar “Fundamentos SpyreStudios 

InDesign”. 

Com isso feito, deve ver agora este pedaço de texto em cada uma de suas páginas da 

mão esquerda - pode simplesmente copiar e colar na caixa de texto na sua página mão 

direita, se quer que ele apareça lá, também, a menos que queira adicionar números de 

página. Nesse caso,  leia o passo seguinte. 

Páginas Mestre e números de página atuais

Provavelmente pergunta-se como adicionar números de página à sua página. Isto é 

surpreendentemente fácil. Ainda vendo o Master-A página principal, clique na sua caixa 

de texto existente. Redimensioná-la de modo que é a largura das margens na sua página. 

Clique duas vezes na caixa de texto para começar a editar o texto e mova o cursor para o 

início da sua caixa de texto antes que qualquer outro texto apareça.

Ir para Tipo> Inserir caractere especial> Marcadores> Número da página atual. A letra 

“A” irá aparecer. Esta carta representa o mestre A-Grade-Rodapé - basicamente o que 

significa que sabe o que a página atual em que está, e vai realmente apresentar o número 

da página em suas páginas reais e não a sua página principal. 
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Para adicionar um pouco de espaço em branco entre o nosso número da página e nosso 

texto normal, ir para Tipo> Inserir espaço em branco> Espaço Em.
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Agora precisamos de duplicar o nosso número de página da esquerda rodapé e texto 

para a nossa página direita na página principal mestre-A. Fazer isso é muito simples. 

Poderia, claro, apenas digitá-lo novamente, mas se quiser salvar um minuto ou dois, 

pode simplesmente selecionar a ferramenta de seleção e, embora mantendo a tecla Alt 

no Windows, ou a tecla Option no Mac OS, clique na caixa de texto de rodapé e arraste-o 

para a outra página, certificando-se que seja alinhado com as guias corretos.

Clique duas vezes na sua caixa de texto de novo e selecione todo o texto dentro dela 

e alinhe-o para a direita. Excluir o Espaço Em, e depois cortar e colar o “A” para o lado 

direito do seu texto e, em seguida, insira novamente o Espaço Em usando a mesma 

técnica que usamos anteriormente.

Agora deve ser capaz de visualizar qualquer uma das suas páginas, e ver que o número 

de página correto está a ser exibido! Isso funciona para qualquer documento tamanho 

que tem - se é 5 páginas, 50 páginas ou 500 páginas.

Renomeando & Criação de novas páginas mestras

Como mencionado anteriormente, o InDesign pode suportar mais de uma página 

principal, tornando-se possível ter determinadas secções usar uma página mestre, e 
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ao resto do uso de documentos outra página mestre. Se vai fazer isso, renomear suas 

páginas mestras é incrivelmente útil para evitar o uso do errado. Demora apenas 10 

segundos para renomear uma página mestre.

Dê um duplo clique na sua página mestre “Um Mestre” e selecione a lista suspensa no 

painel de páginas (ver imagem abaixo). Selecione “Opções de mestre para um Mestre”.

Exercício número 1

PROPOSTA DE TRABALHO

O que são páginas mestres?

Exercício número 2

PROPOSTA DE TRABALHO

O que é uma guia?

Um Mestre janela Opções irá aparecer, permitindo que modifique o seu prefixo (A), o seu 

nome (Master), o mestre é baseado em (Nenhum) e quantas páginas a página principal 

tem (2). Mudar o nome para “Guias de grade e números Rodapé”.
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Vai ver agora que “um mestre” foi alterado para “A-Grid Guias & número de rodapé”.

Para criar novas páginas mestras, pode selecionar a opção novo mestre da mesma queda 

para baixo lista que acabou de usar. Chame este mestre «Shape Cabeçalho”. Ao basear 

o mestre noutro mestre (Guias ou seja, nossa grade & página mestre rodapé Number) 

será, em princípio, exatamente o mesmo.

Podemos adicionar novos elementos para esta página mestre, enquanto ainda mantém 

os elementos do nosso mestre original. Isto é especialmente útil para este caso particular, 

como ainda queremos os nossos números de página apareçam em todas as páginas que 

a nossa nova página mestra é aplicada muito bem.

Clique duas vezes em seu novo mestre para vê-lo em nossa janela do documento principal. 

Deve olhar idêntica à nossa página mestre original. Todas as alterações que fazemos a 

nossa página mestre original também será exibido em nossa nova página principal.

Criando um simples elementos gráficos de cores e espaços 
reservados título

Nós vamos criar um simples gráfico de uma cor e um espaço reservado de texto para a 

nossa nova página mestra, que irá funcionar como um cabeçalho para secções específicas 

do nosso documento.
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Primeiro, verifique se está a ver a nossa nova página principal. Selecione a ferramenta 

Retângulo e arraste uma seleção sobre a nossa página dupla, como pode ser visto abaixo. 

Encha-a com uma cor de sua escolha. Lembre-se, estamos apenas a aprender a usar os 

recursos InDesigns aqui - portanto, não passar horas apenas fazendo as coisas parecem 

boas! Certifique-se de a sua forma espalha direito até a borda do sangramento. Vai 

notar que esta forma azul só aparece na nossa nova página principal, e não na nossa 

original. Ela também não aparece em qualquer uma das nossas páginas, no entanto, 

ainda não aplicou esta página mestra para qualquer um delas!

Em seguida, vamos adicionar um título (cabeçalho) do espaço reservado. Com a sua 

nova página principal ainda selecionada, selecione a ferramenta de texto e arraste uma 

caixa de texto sobre a sua nova forma azul - só esticar a caixa de texto até à margem 

direita na página esquerda. Tipo “Título Uma ...”, aumentar o tamanho do texto e mudar 

a cor (se quiser também!). Repita o mesmo processo para o site da direita da nossa 

página principal, mas desta vez com menos texto - talvez esta área poderia ser alargada 

para uma cotação.
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Aplicando Páginas Mestras para páginas de documentos

Nós agora vamos configurar as duas páginas mestras - uma das quais já foi 

(automaticamente) aplicada a todas as nossas páginas. Agora, no entanto, precisamos 

que tudo esteja arrumado. Para começar, não queremos os nossos números de página 

a serem exibidos na nossa capa e contracapa, uma vez que existem (obviamente) e não 

cobrem as páginas. Nós também queremos aplicar à nossa página principal cabeçalho 

para alguns das nossas duplas-páginas.

Remover e aplicar páginas-mestre a páginas de documentos é muito simples. Tudo o 

que tem a fazer é arrastar e soltar. Na parte superior do painel de páginas, terá três 

páginas mestras: “Nenhum”, “A” e “B”.

Clique e arraste “Nenhum” para a sua frente e tampa traseira. Vai ver agora que a sua página 

não contém nada, mas a sua primeira página ainda está numerada “2”. Para mudar isso, 

clique com o botão direito 

na sua primeira página (a 

página lado esquerdo da 

sua propagação primeira 

dupla) e selecione Opções 

de numeração e secção. 

A “Nova Seção” janela 

aparecerá. Certifique-se de 

“Start Page Numbering at:” 

é selecionado, e mudar “1” 

para “2”. Clique em OK.
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Arraste o “B” página mestre para qualquer uma das páginas que deseja ter um título 

diante. Vou colocar em todas as páginas de propagação outra dupla, como pode ser visto 

abaixo.
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Substituindo Objetos Master Page

No seu estado atual, não pode realmente aumentar o zoom para uma das nossas páginas 

de documentos e editar o texto de espaço reservado que aplicamos o nosso “B” da 

página principal.

Isto porque todo o conteúdo das nossas páginas mestre está atualmente bloqueado 

para evitarmos acidentalmente clicar em, redimensionar e mover o conteúdo. Nós não 

queremos ser capazes de fazer isso como padrão, pois iria contra todo o objeto de ter 

páginas mestras, que é para manter o nosso projeto consistente em todo o documento.

Substituindo os nossos itens de página-mestre em páginas dos nossos documentos é 

uma tarefa muito fácil, porém, não se preocupe! Tal como acontece com a maioria das 

coisas no InDesign, é fácil.

O direito de zoom no seu primeiro título que deseja editar. Se tentar selecionar a sua 

caixa de texto do espaço reservado contendo “uma posição ...” ele simplesmente não 

vai reconhecer que ele está lá. Há uma maneira simples de “desbloquear”, no entanto, 

mantenha a tecla Shift + Ctrl (Windows) ou Shift + Command (Mac OS), e tente clicar na 

caixa de texto do espaço reservado.

Agora deve ser capaz de editá-lo - colocar numa posição que se adapte a esta página 

particular. Fazendo isso irá desbloquear a caixa de texto para sempre, e não apenas de 

forma temporária - tenha a certeza que não quer movê-la.

Pode usar exatamente a mesma técnica para selecionar a citação e a forma azul. 

Selecione a forma azul, e vamos mudar a sua cor - de novo, isso irá desbloquear a forma 

para sempre, e não apenas numa base temporária.

ManualArtesGraficasEdicaoEletronicaMod5a8.indd   128 14-03-2014   17:45:58



Manual do Aluno

CURSO TÉCNICO DE  ARTES GRÁFICAS | 129

Adicionar, organizar e apagar páginas

Até agora deve apreender as ferramentas básicas, páginas e opções de página-mestre no 

InDesign, e provavelmente já viu como adicionar, organizar e apagar páginas do InDesign 

já, se não por fim, por engano!

Adicionar novas páginas é um recurso muito útil. Nunca se sabe quando pode precisar 

de uma página extra ou duas - talvez um cliente tenha encontrado um outro anunciante 

no último minuto ou outro artigo veio em cima do prazo? Sem esses recursos, seria uma 

dor muito grande para voltar a fazer tudo!

No painel páginas, há um símbolo de nova página na parte inferior - similar ao utilizado 

para nova camada em ambos Photoshop e Illustrator. Quando clicar neste, ele insere 

uma página abaixo do que está atualmente, e também aplica as páginas mestras a esta. 

Queremos inserir um spread abaixo da sua nova dupla última página de título. Com a 

última página título selecionado, clique no ícone de página nova. Uma nova página que 

se parece exatamente igual com a de cima vai aparecer.

Nós não queremos isso para que a página principal título aplicado, portanto, basta 

arrastar “Nenhum” para a propagação nova página dupla, e em seguida, arraste o 
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“A” página principal sobre a mesma. Isto vai dar à nova página o texto de rodapé e  a 

numeração de páginas.

Eliminar páginas é tão fácil quanto selecionar a página que deseja excluir e clique no 

ícone de exclusão chave diretamente ao lado do ícone nova página, e para reorganizar 

certas páginas pode simplesmente clicar e arrastar uma página no seu painel de páginas 

para sua nova posição. Como temos utilizado a página especial recurso de numeração, 

todos os números de página atualizar-se-ão automaticamente.

Criar Frames texto com colunas

A criação de quadros de texto com colunas é outro recurso InDesign. Estamos a adicionar 

este quadro de texto para o nosso “B” quadro de página mestre para que ele seja aplicado 

a todas as nossas páginas com a página mestre particular aplicado - o que irá nos salvar 

de fazer a mesma coisa várias vezes.

Dê um duplo clique na sua página principal “B”, e selecione o tipo de ferramenta. Arraste 

uma nova caixa de texto, certificando-se que ela se encaixe para cada margem.
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Copie a caixa de texto que acabámos de criar, e cole-o no lado direito, certificando-se 

que as linhas estão contra as mesmas guias e margens. Como este é um layout de revista 

/ livro, queremos que essas duas caixas de texto em link, para que os primeiros fluxos 

um para o segundo. Nós também queremos que eles tenham duas colunas. Assim, no 

total, haverá quatro colunas ao longo de duas páginas, que fluem para a coluna seguinte.

Selecione a ferramenta de seleção e clique na sua primeira caixa de texto, e em seguida, 

enquanto pressiona a tecla Shift, clique na sua segunda caixa de texto. Com as duas 

selecionadas, selecione o tipo de ferramenta. No painel de controle acima da sua janela 

do documento, clique na seta ao lado da caixa de colunas a aumentar para dois (ver 

imagem abaixo).
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Agora precisamos de vincular as nossas duas caixas de texto com colunas em conjunto 

para que flua num outro. Isso é muito fácil de fazer, mas é muito difícil de explicar. 

Selecione a ferramenta de seleção e clique na sua primeira caixa de texto. Vai notar 

que há uma pequena praça em direção ao canto inferior do lado direito - veja a imagem 

abaixo.

Clique no pequeno quadrado. Um ícone deve aparecer – deve-se olhar como várias linhas 

de texto. Uma vez que apareceu, clique diretamente na sua segunda caixa de texto. O 

ícone que acabou de ver (do texto) deve ter-se transformado numa pequena cadeia. Se 

ele tem caixas de texto estão agora oficialmente ligadas! Se não, tente novamente - vai 

descobrir isso eventualmente!

Importação de texto para o seu Documento

O InDesign não é um aplicativo de edição de texto, e não foi projetado para escrever o 

seu texto diretamente para ele - embora seja perfeitamente capaz de fazê-lo, os editores 

tendem a escrever a sua cópia num aplicativo que é dedicado ao processamento de 

texto, como o Microsoft Word ou OpenOffice Writer.

Se ainda não tem qualquer texto que deseja colocar no seu documento, crie rapidamente 

um documento fictício. Na verdade, estou a usar o arquivo original do que está a ler 

atualmente.

Vá a File> Place, e selecione um. Doc. Quando abrir o seu documento de texto, vai ver 

as primeiras linhas do mesmo. Basta clicar sobre a caixa de texto, e os documentos. O 

conteúdo doc será colocado automaticamente na sua caixa de texto, e deve fluir através 

de todas as quatro colunas como configurado na etapa anterior.
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Colocando o texto automaticamente, copiar os estilos que foram usados no documento. 

Para alterá-lo de volta ao “normal” pode destacar todo o texto na caixa de texto e 

simplesmente mudar a fonte e o tamanho do texto. Também pode jogar com o líder 

de rastreamento para que ele comece a olhar como quer. Lembre-se, esta é apenas 

um exercício prático. Nós vamos para as definições de tipografia num futuro tutorial “O 

confronto com o InDesign”.
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Criação de Índice/Sumário

Um sumário pode registar o conteúdo de um livro, revista ou outra publicação; exibir uma 

lista de créditos de ilustrações, anunciantes e fotografias; ou incluir outras informações 

para ajudar os leitores a encontrar informações num documento ou arquivo de livro. Um 

documento pode ter vários sumários (por exemplo, uma lista de capítulos e uma lista de 

ilustrações).

Cada sumário é uma matéria distinta com um título e uma lista de entradas classificadas 

por número de página ou alfabeticamente. As entradas, incluindo números de página, 

são obtidas diretamente do conteúdo do documento e podem ser sempre atualizadas, 

mesmo entre vários documentos de um arquivo de livro.

O processo para criação de um sumário requer três etapas principais. Primeiro, crie e 

aplique os estilos de parágrafo que usará como base para o sumário. Segundo, especifique 

quais estilos são usados no sumário e como o sumário é formatado. Terceiro, copie o 

sumário para o documento.

As entradas do sumário podem ser adicionadas automaticamente ao painel ‘Marcadores’ 

para uso em documentos exportados como Adobe PDF.

Dicas para criar um sumário

Ao planear um sumário, considere o seguinte:

Alguns sumários são criados a partir de conteúdo que, na verdade, não é exibido no 

documento publicado (como uma lista de anunciantes em uma revista). Para fazer isso 

no InDesign, digite o conteúdo em uma camada oculta e inclua-o ao gerar o sumário.

É possível carregar estilos de sumário de outros documentos ou livros para criar novos 

sumários com as mesmas configurações e formatação. Talvez seja necessário editar um 

estilo de sumário importado se os nomes de estilos de parágrafo no documento não 

corresponderem aos do documento de origem.

É possível criar estilos de parágrafo para o título e entradas do sumário, incluindo 

paradas e guias de tabulação. Poderá, então, aplicar esses estilos de parágrafo ao gerar 

o sumário.
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É possível criar estilos de caracteres para formatar os números de página e os caracteres 

que os separam das entradas. Por exemplo, se desejar que os números de página 

apareçam em negrito, crie um estilo de caracteres que inclua o atributo negrito e 

selecione esse estilo quando criar o sumário.

Criação de sumários em livros

Para obter melhores resultados, siga estas etapas antes de criar um sumário para um 

livro:

Antes de criar um sumário, verifique se a lista do livro está completa, se todos os 

documentos estão listados na ordem correta e se todos os títulos foram formatados 

com os estilos de parágrafo adequados.

Use estilos de parágrafo uniformes em todo o livro. Evite criar documentos com estilos 

que tenham nomes idênticos e definições diferentes. Se vários estilos tiverem o mesmo 

nome e definições diferentes, o InDesign usará a definição de estilo do documento atual 

(caso haja alguma) ou a primeira ocorrência do estilo no livro.

Se os estilos necessários não aparecerem nos menus pop up da caixa de diálogo ‘Sumário’, 

será necessário sincronizar o livro para que os estilos sejam copiados para o documento 

que contêm o sumário.

Se desejar exibir prefixos de número (como 1-1, 1-3 etc.) no sumário, use a numeração 

de secção em vez da numeração de capítulo. É possível incluir prefixos de número de 

secção num sumário.

Gerar um sumário

Antes de gerar um sumário, decida quais os parágrafos que serão incluídos (por exemplo, 

títulos de capítulo e de secção); em seguida, defina estilos de parágrafo para cada um 

deles. Verifique se esses estilos são aplicados a todos os parágrafos apropriados do 

documento ou dos documentos do livro.

Ao gerar o sumário, você também pode usar estilos de parágrafo e caracteres para 

formatá-lo.
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Sumário sem estilos de parágrafo (à esquerda) e com estilos de parágrafo aplicados às 

entradas (à direita)

Se os parágrafos que devem ser inclusos no sumário aparecerem em diferentes matérias 

na mesma página, a sua ordem nesse sumário será determinada pela posição que 

ocupam na página.

Siga um destes procedimentos:

Se estiver a criar um sumário para um único documento, poderá incluir uma nova página 

no início do documento.

Se estiver a criar um sumário para vários documentos de um livro, crie ou abra o 

documento a ser usado para o sumário, verifique se ele foi incluído no livro e abra o 

arquivo de livro.

Escolha ‘Layout’ > ‘Sumário’.

Se definiu um estilo de sumário que tem as configurações apropriadas para o seu 

sumário, poderá selecioná-lo no menu ‘Estilo de sumário’.

Na caixa ‘Título’, digite um título para o sumário (como Conteúdo ou Lista de figuras). 

Esse título será exibido no início do sumário. Para formatar o título, escolha um estilo no 

menu ‘Estilo’.

Selecione ‘Incluir documentos de livro’ para criar um único sumário para todos os 

documentos existentes na lista do livro e para renumerar as páginas do livro. Desmarque 
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essa opção se desejar gerar um sumário somente para o documento atual. Essa opção 

aparecerá esbatida se o documento atual não fizer parte de um arquivo de livro.

Determine qual o conteúdo que deseja incluir no sumário, clicando duas vezes nos estilos 

de parágrafo na lista ‘Outros estilos’ para adicioná-los à lista ‘Incluir estilos de parágrafo’.

Selecione ‘Substituir sumário existente’ para substituir todas as matérias de sumário 

existentes no documento. Desmarque essa opção se desejar gerar um novo sumário; por 

exemplo, uma lista de figuras.

Especifique opções para determinar como cada estilo de parágrafo no sumário será 

formatado. (Consulte Opções para formatar um sumário.)

É uma boa ideia definir um estilo de sumário que contenha a formatação e outras 

opções, especialmente se quiser incluir vários sumários no documento. Para fazer isso, 

clique em ‘Salvar estilo’. Também é possível criar estilos de sumário escolhendo Layout 

> Estilos de sumário.

Clique em ‘OK’.

Será exibido um cursor de texto carregado . Antes de clicar ou arrastar, pode ir para outra 

página ou criar uma nova página sem perder o texto carregado.

Clique ou arraste o cursor de texto carregado numa página para inserir a nova matéria 

de sumário.

Criar estilos de sumário para listas múltiplas

Use estilos de sumário se tiver que criar sumários diferentes no documento ou livro. Por 

exemplo, é possível usar um estilo de sumário para uma lista de conteúdo e outro para 

uma lista de créditos de anunciantes, ilustrações ou fotos. Crie um estilo de sumário para 

cada tipo de lista.

Criar estilos de sumário também é útil caso deseje usar a mesma formatação de sumário 

noutro documento.

Nota: Não confunda estilos de sumário com estilos de parágrafo com um prefixo “Analítico”. 

Os estilos de parágrafo com o prefixo Analítico (por exemplo, “título do sumário”) são 

usados para formatar as entradas de sumário. Por outro lado, um estilo de sumário é um 

conjunto de configurações usadas para criar automaticamente um sumário.
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Criar um estilo de sumário

Escolha ‘Layout’ > ‘Estilos de sumário’.

Clique em ‘Novo’.

Digite um nome para o estilo de sumário que está a criar.

Na caixa ‘Título’, digite um título para o sumário (como Conteúdo ou Lista de figuras). 

Esse título será exibido no início do sumário. Para especificar um estilo de título, escolha 

o estilo no menu ‘Estilo’.

Na lista ‘Outros estilos’, selecione os estilos de parágrafo que representam o conteúdo 

a ser incluído no sumário; em seguida, clique em ‘Adicionar’ para adicioná-los à lista 

‘Incluir estilos de parágrafo’.

Especifique opções para determinar como cada estilo de parágrafo é formatado. 

(Consulte Opções para formatar um sumário.)

Importar estilos de sumário de outro documento

Escolha ‘Layout’ > ‘Estilos de sumário’.

Clique em ‘Carregar’, selecione o arquivo do InDesign que contém os estilos de sumário 

que deseja copiar e clique em ‘Abrir’.

Clique em ‘OK’.

Opções para formatar um sumário

Ao gerar ou editar um sumário, use estas opções para determinar a aparência do texto 

do sumário gerado. Algumas dessas opções só permanecem disponíveis quando clica 

em Mais Opções na caixa de diálogo.

Nota: As configurações da secção ‘Estilo’ são aplicadas apenas ao estilo selecionado no 

momento em ‘Incluir estilos de parágrafo’. É possível especificar diferentes opções de 

formatação para cada estilo.

‘Estilo da entrada’

Para cada estilo em ‘Incluir estilos de parágrafo’, escolha um estilo de parágrafo para 

aplicar às entradas de sumário associadas. 
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‘Número de página’

Poderá criar um estilo de caracteres para formatar o número de página. Em seguida, 

poderá selecionar este estilo na lista pop up ‘Estilo’ à direita de ‘Número de página’. 

(Consulte Adicionar estilos de parágrafo e de caracteres.)

Se desejar incluir prefixos nos números de página do sumário ou usar outra convenção 

de numeração, consulte Definir a numeração de secções.

‘Entre a entrada e o número’

Especifique os caracteres a serem exibidos entre a entrada de sumário e o número 

de página correspondente. O padrão é ^t, que informa ao InDesign para inserir uma 

tabulação. Pode escolher outros caracteres especiais, como ‘Tabulação de recuo à 

direita’ ou ‘Espaço eme’, na lista pop-up. Para obter uma lista completa de caracteres 

especiais e aprender a trabalhar com eles, consulte Inserir glifos e caracteres especiais.

Selecione o texto existente na caixa antes de escolher outro caractere especial, para não 

incluir os dois caracteres simultaneamente.

Pode criar um estilo de caracteres para formatar o espaço entre a entrada e o número de 

página. Em seguida, selecione-o na lista pop-up ‘Estilo’, à direita de ‘Entre a entrada e o 

número’. (Consulte Adicionar estilos de parágrafo e de caracteres.)

Se o estilo de parágrafo da entrada incluir uma configuração de tabulação, e os carac-

teres de guia de tabulação (^t) for selecionado, aparecerá uma guia de tabulação no 

sumário gerado. Para obter instruções, consulte Criar entradas de sumário com guias de 

tabulação.

Você pode especificar um caractere para separar a 

entrada do número de página, e também um estilo 

para aplicar a um desses caracteres.
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Exercício número 3

PROPOSTA DE TRABALHO

As entradas do sumário podem ser adicionadas automaticamente ao painel 

‘Marcadores’ para uso em documentos exportados como Adobe PDF? Verdadeiro ou 

Falso.
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Preparação para impressão de 
separações

Criação de separações

Para reproduzir imagens coloridas e de tonalidades contínuas, as impressoras geralmente 

separam a arte em quatro chapas — uma chapa para cada parte em ciano (C), magenta 

(M), amarelo (Y) e preto (K) da imagem. Quando recebem a tinta da cor apropriada e 

são impressas em registo umas com as outras, essas cores combinam-se para reproduzir 

a arte original. O processo de dividir a imagem em duas ou mais cores é denominado 

separação de cores, e os filmes dos quais as chapas são criadas são denominados 

separações.

Composto (esquerda) e separações (direita)

Processos de produção de separações

O Adobe InDesign CS4 suporta dois processos de produção comuns de PostScript. A 

principal diferença é onde as separações são criadas: no computador host (o sistema que 

usa o InDesign e o driver de impressora) ou no RIP (processador de imagens rasterizadas) 

do dispositivo de saída. Outra alternativa é o processo de produção de PDF.

ManualArtesGraficasEdicaoEletronicaMod5a8.indd   142 14-03-2014   17:46:04



Manual do Aluno

CURSO TÉCNICO DE  ARTES GRÁFICAS | 143

Separações baseadas no host

No processo de produção tradicional pré-separado baseado no host, o InDesign cria 

informações PostScript para cada separação necessária para o documento e as envia 

para o dispositivo de saída.

Separações In-Rip

No processo de produção baseado em RIP mais recente, uma nova geração de RIPs 

PostScript executa separações de cores, trapping e até gestão de cores no RIP, deixando o 

host livre para executar outras tarefas. Essa abordagem faz com que o InDesign leve menos 

tempo para gerar o arquivo e minimiza a quantidade de dados transmitidos para qualquer 

tarefa de impressão. Por exemplo, em vez de enviar informações PostScript para quatro ou 

mais páginas a fim de imprimir separações de cores baseadas no host, o InDesign envia-as 

para um único arquivo PostScript composto para processamento no RIP.

Preparar o documento para separações de cores

1.	 Corrija quaisquer problemas de cores na arte.

2.	 Defina opções de superimposição.

3.	 Crie instruções de trapping para compensar erros de registo na impressora 

tipográfica.

4.	 Visualize as separações de cores na tela.

5.	 Nota: As etapas de 1 a 4 são recomendadas, mas não essenciais para produzir 

separações de cores.

6.	 Escolha ‘Arquivo’ > ‘Imprimir’, para exibir a caixa de diálogo ‘Imprimir’.

7.	 Se tiver criado uma predefinição de impressora com as configurações de 

separação apropriadas, selecione-a no menu ‘Predefinição de impressão’ na 

parte superior da caixa de diálogo ‘Imprimir’.

8.	 Escolha uma impressora ou arquivo PostScript no menu ‘Impressora’.

9.	 Se estiver a imprimir num arquivo PostScript, escolha a PPD referente ao 

dispositivo que imprimirá as separações.
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10.	Para exibir ou alterar opções de impressão existentes, clique num nome de 

secção no lado esquerdo da caixa de diálogo ‘Imprimir’.

11.	Antes de entregar o documento a um prestador de serviços, faça a prova das 

separações.

12.	Imprima ou salve as separações.

Saída de cores especiais

É possível usar tintas personalizadas, denominadas cores especiais, juntamente com as 

cores de escala ou no lugar delas. Por exemplo, em vez de usar as quatro cores de escala 

para reproduzir a arte com texto em preto e desenhos com linhas verdes azuladas, pode 

usar duas cores especiais — uma cor para o preto e outra representando o tom exato do 

verde. Pode usar tintas de cores especiais para criar cores que não sejam reproduzíveis 

por tintas CMYK, como cores fluorescentes e metálicas. Pode também misturar cores 

especiais, ou cores especiais com cores de escala para criar tintas mistas.

É possível colorir uma arte com cores de escala, cores especiais ou uma combinação de 

ambas. Ao imprimir separações, pode converter cores especiais nos seus equivalentes 

de cor de escala para que sejam impressas nas chapas CMYK.

Impressão de um composto

Pode imprimir uma prova composta em cores ou escala de cinza para ver as cores do 

documento. Uma imagem composta pode ajudá-lo a criar e fazer a prova do seu layout 

antes de imprimir separações finais (que são caras).

Quando o InDesign imprime um composto, ele imprime todas as cores utilizadas no 

arquivo numa única chapa, não importa se foram selecionadas algumas cores individuais.

Considere os seguintes problemas ao imprimir compostos:

Embora nenhuma prova forneça a representação exata da saída final, pode aumentar 

bastante a precisão por meio da calibragem de todos os dispositivos usados na criação de 

um documento (como scanners, monitores e impressoras). Se os dispositivos estiverem 

calibrados, o sistema de gestão de cores poderá ajudá-lo a obter cores previsíveis e uniformes.
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As opções de superimposição selecionadas no documento serão impressas corretamente 

numa impressora que suporte a superimposição. Como a maioria das impressoras de 

mesa não suporta a superimposição, pode simular os seus efeitos selecionando ‘Simular 

superimposição’ na secção ‹Saída› da caixa de diálogo ‹Imprimir›.

Importante: A seleção de ‘Simular superimposição’ converterá cores especiais em cores 

de escala para impressão. Se desejar usar um arquivo para separações num RIP ou para 

saída final, não selecione esta opção.

Ao imprimir numa impressora em preto-e-branco, o InDesign produzirá uma versão 

composta de escala de cinza nas páginas. Se o documento contiver cores, o InDesign 

imprimirá cinzas visualmente corrigidos para simular essas cores. Por exemplo, o cinza 

que simula uma tonalidade de amarelo a 20% é mais claro do que uma tonalidade de 

20% de preto, pois o amarelo é mais claro que o preto.

Ao imprimir um livro com capítulos contendo estilos de trapping ou tintas especiais em 

conflito, é possível instruir o InDesign a sincronizar as configurações com o documento-

mestre.

Se estiver a usar a gestão de cores com o recurso Livro, verifique se cada documento no 

livro usa as mesmas configurações da gestão de cores na caixa de diálogo Configurações 

de Cor.

Exercício número 4

PROPOSTA DE TRABALHO

É possível usar cores especiais na separação de cores? Verdadeiro ou Falso.
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